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SMaRT AFIX Installation
Instructions

The following provides an overview of the process for installing the SMaRT AFIX
application.

Components

SMaRT AFIX is composed of several server components. The following includes their
functions and brief technical descriptions.

Standalone Forecaster (SAF)

SAF is a web application that evaluates patient and vaccination data to produce a
vaccination forecast for that patient. It provides both a user interface and a SOAP web
service. For SMaRT AFIX, only the web service is used.

SAF runs under Apache Tomcat 7.0 and is deployed as a -war file. It utilizes an Oracle
Express Database (XE) to store pre-configured vaccination schedules and
configuration data.

Standalone Forecaster is installed on the Service box.

PostgreSQL
SMaRT AFIX utilizes PostgreSQL 9.4 as a database. An additional Postgres module,
pg_partman, is required. The name of the database is afixdb. It is created via several

-sql scripts. See SMaRT AFIX Database Initialization - Linux or Windows for the
installation instructions.

JasperReports Server (JRS)

JRS is a web application that provides the reports for SMaRT AFIX. These reports are
imported into JRS via the JRS Management Console. See SMaRT AFIX JasperReports
Deployment - Linux or Windows for installation instructions.

Jaspersoft ETL (JETL)

Patient, vaccination, and provider data are batch-loaded into the SMaRT AFIX
database on a nightly basis. Once this data has loaded, it is run through the
Standalone Forecaster and aggregated into tables that are designed for reporting.
These batch processes are scheduled and executed by Jaspersoft ETL.
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SMaRT AFIX Application

The Ul and application server logic are provided via the SMaRT AFIX application. This
is a Node.js application and uses Keycloak for user authentication.

Keycloak

User authentication is provided by Keycloak. It is used by all STC Suite applications
for Single Sign-On (SSO). Each application requires a client within Keycloak. The
client contains references (URLs, ports, etc.) that are specific to each individual

SMaRT AFIX application.

New Application Installations

The following refers to new application installations, not necessarily to upgrade
installations. The instructions differ between Linux and Windows installations as well. If
you are building a new Linux Server, see the Build a Linux (CentOS) Server instructions.

NOTE: The SMaRT AFIX components should be installed in the order listed below.

Component \Server \Linux Windows
Keycloak Installation Service See either Keycloak Installation Guide for
(SVO) STC-Hosted Clients or Keycloak Installation
Guide for Self-Hosted Clients.
Standalone Forecaster Service Forecaster Forecaster Installation
(SVO) Installation Instructions -
Instructions - Linux [(Windows
PostgreSQL Server (if not already Database Postgres Database Postgres Database
installed) and Batch Installation - Linux Installation - Windows
(DBB)
SMaRT AFIX Database Database SMaRT AFIX SMaRT AFIX Database
and Batch Database Initialization -
(DBB) Initialization - Linux [(Windows
SMaRT AFIX Online Tool Service SMaRT AFIX Online SMaRT AFIX Online
(SVO) Tool Web Service Tool Web Service
Installation Installation
Instructions - Linux |Instructions -
Windows
Jaspersoft ETL Server (if not already |Database Jaspersoft ETL Jaspersoft ETL

installed) (NOTE: Initial ETL loads can |and Batch Installation_- Linux Installation_- Windows
take several days; it's recommended [(DBB)
to have them running while other
components are being installed.)
SMaRT AFIX ETL Database SMaRT AFIX SMaRT AFIX

and Batch Jaspersoft ETL Jaspersoft ETL

(DBB) Deployment - Linux |Deployment -

Windows

JasperReports Server (if not already |Application [JasperReports Server |JasperReports Server
installed) (APP) Installation - Linux Installation - Windows

SMaRT AFIX (v. March 2018) Installation Guide
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Component \Server \Linux Windows

SMaRT AFIX Reports Application |SMaRT AFIX SMaRT AFIX
(APP) JasperReports JasperReports
Deployment - Linux |Deployment -
Windows
Node.js Server (if not already Application |Node.js Installation - |Node.js Installation -
installed) (APP) Linux Windows
SMaRT AFIX Application Installation Application |SMaRT AFIX SMaRT AFIX
(APP) Application Application
Installation Installation
Instructions - Linux Instructions -
Windows
Keycloak Configuration for SMaRT Service Keycloak Configuration for SMaRT AFIX
AFIX (SVC) (Linux and Windows)
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Linux Instructions

The following instructions are for the Linux operating system.

Build a Linux (CentOs) Server

The instructions below explain how to install CentOS 7 Minimal and configure it. This is a
base configuration suitable for reuse for all servers. An image or snapshot should be
taken, if possible (such as in a cloud or AWS environment), so that these steps do not
need to be performed again. Initially, the server is usually set up with the following:

e CentOS 7 Minimal (64-bit)
e 64-bit CPU

e 2GB RAM minimum

e 50GB HD minimum

These requirements are only for the initial setup. CPU, RAM, and storage requirements
vary based on server use. Check the STC Suite specifications document prior to installing
additional components on the server.

The instructions below explain how to build a base server from scratch. After following

these steps, an image should be created so that these steps do not need to be performed
again.

Install CentOS 7 Minimal and Configure

CentOS 7 Minimal is installed in order to be able to start from a lean Linux installation.
Packages and software components are added as needed.

1. Disable the SSH login as root - Run the remainder of this steps as root or use
sudo.

2. Edit sshd_config. Vi is used here, but any editor can be used.

sudo vi /etc/ssh/sshd_config

3. On the line that says #PermitRootLogin yes, update it to the following (remember
to remove the #):

PermitRootLogin no

4. Restart the sshd service:

sudo service sshd restart
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5. By default, SELinux is set to be enforced. Change this by running:

sudo setenforce 0O

6. Edit the following file so permissive persists across reboots:

sudo vi /etc/selinux/config

7. Change the line SELINUX=enforcing to the following and save the changes:

SELINUX=permissive

8. Make sure the software is completely up to date:

sudo yum update

9. Finally, install some basic packages:

sudo yum -y install net-tools gcc-c++ openssl-devel make git unzip bzip2
wget vim-enhanced ntp epel-release tmux dos2unix patch

Forecaster Installation Instructions - Linux

The installation of the Standalone Forecaster (SAF) is composed of three major tasks:
install Oracle Express, install the SAF database into Oracle Express, and install the
Forecaster web application into Tomcat. All three components are installed on the Service
machine (SVC).

Install Oracle Express

Perform the following steps as root user.

1. Install the OS libraries and packages on the Linux machine on which XE will be
installed:

yum install bc binutils flex gcc glibc glibc-common glibc-devel libaio
libstdc libXtst make sysstat

2. Create the Oracle user and the Oinstall group:

/usr/sbin/groupadd oinstall
/usr/sbin/groupadd dba

/usr/sbin/useradd -g oinstall -G dba oracle
passwd oracle (Oraclel23)

id oracle

3. Download the Oracle XE rpm, oracle-xe-11.2.0-1.0.x86_64.rpm.zip, from
http://www.oracle.com/technetwork/database/database-technologies/express-
edition/downloads/index.html and copy it to the server.
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4. In the directory where the oracle-xe-11.2.0-1.0.x86_64.rpm.zip file is copied
on the server, run these commands:

unzip -gq oracle-xe-11.2.0-1.0.x86_64.rpm.zip
cd Diskl
rpm -i oracle-xe-11.2.0-1.0.x86_64.rpm

5. If the installation is successful, run this command as root. When it asks for an
HTTP port, change it to 7080 so that it doesn't conflict with other installation
applications. Set the initial SYS & SYSTEM password to WELCOME.

/etc/init.d/oracle-xe configure

6. Verify the connection to the database:

cd /u0l1/app/oracle/product/11.2.0/xe/bin
-/oracle_env.sh
sqlplus system/<password>0OXE

7. Get the database connection information:

[oracle@ ~]$ cd /uOl/app/oracle/product/11.2.0/xe/network/admin
[oracle@ ~]$ cat tnsnames.ora

Install the SAF Database (New Installation)

Copy the /SVC/0XE/db/ directory and all of its contents to your server under the Oracle
user's home directory.

It is recommended you change the owner and permissions of the db directory by running
the below commands as root:

chown -R oracle:oinstall db
chown -R 775 db

To install the SAF database, navigate to the
/db/AF1X_CDSI1_Install/AFIX_CDS1_v5.16.9 Install/ directory and execute the
following command as user oracle. Note that your path to bin/oracle/env.sh may
differ.

./u0l/app/oracle/product/11.2.0/xe/bin/oracle_env.sh
sh Install.sh

Next, navigate to /db/Patches/ and run the following:

/patch_v5 17 CDSI/forecast.sh
/patch_v5 18 CDSI/forecast.sh
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Run Database Patches (Upgrades)

To update the Forecaster database to the most current patch version, navigate to
/db/Patches/ and run the following:

/patch_v5 18 CDSI/forecast.sh

Install the Web Application

Before installing the SMaRT AFIX web application, Java 7 must be installed on the SVC
server and Tomcat 7.0 must also be installed and running on the SVC server.

1. Edit the conf/context.xml file - Add the lines below (between the
<Context></Context> tags) to the CATALINA HOME/conf/context.xml file. The
added lines should be placed within the <Context></Context> tags in the file.

<Context>
<Resource name="jdbc/com/stc/forecaster"
auth="Container"
type=""javax.sql .DataSource™
driverClassName="oracle.jdbc.OracleDriver"
url="jdbc:oracle:thin:@localhost:1521/XE"
username=""SAFUSER""
password=""SAF"
maxActive="100"

maxldle=""10"
maxWait=""-1"/>
</Context>

2. Navigate to the Application /SVC/SAF directory and execute this command:

$ cp forecaster.war $CATALINA_HOME/webapps/forecaster .war

3. Restart Tomcat.

4. Set the number of threads to the number of processor cores available on your
server - Edit $CATALINA_HOME/webapps/forecaster/WEB- INF/spring-ws-
servlet.xml and set the thread count (see the second line of code below):

<bean id="forecastingEndpointl2"
class=""com.stchome.saf.ws.endpoint.ForecasterServiceEndpointl2"
scope=""'prototype'>

<constructor-arg value="1" /><!-- Thread count -->

<constructor-arg value="60" /><!-- Thread pool termination timeout in
seconds-->
</bean>

5. Increase the Tomcat memory usage on your server - Edit
$CATALINA_HOME/bin/setenv.sh and set the thread count (see the second line of
code below):

export CATALINA_OPTS="$CATALINA_OPTS -Xms2048m"
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export CATALINA_OPTS="$CATALINA_OPTS -Xmx2048m"

6. Restart Tomcat.

7. Verify the application is running correctly by navigating to http://[YOUR
SERVER]/forecaster. The Ul displays if the application was successfully installed
and configured.

S I c Forecasting Settings SOAP WSDL Tester

ImmucCast

Forecasting Settings

Vaccine Family Settings Save

Vaccine Famiy

MENINGOCOCCAL B, OMV L4 4 A v |

DTaP/DT/Td/Tdap 4w v i v

HIB 4w v v

POLIO 4v v v

HEP-B 3 DOSE 4 | v v

MMR 4v v v

VARICELLA 4w v | v

MENINGOCOCCAL ERA v v

HEP-A 4 v v

FLU 4 v v

PNEUMO (PCV) 4v v v

HEP-B 2 DOSE 4v v v

MEASLES v 4| v v

MUNMPS v 4v v v

RUBELLA v 4 v v

PNEUMO (PPSV) ERA v v

ROTAVIRUS 4 v v

HPV 4 v v v

HERPES ZOSTER 4v| v v

Vaccine Preferences by Dose to Override ACIP Schedule Recommendations

Postgres Database Installation - Linux

The information below describes how to install the Postgres database on Linux CentOS 7,
as well as how to modify relevant Postgres server configuration settings for SMaRT AFIX.

Install on Linux CentOS 7

Currently, SMaRT AFIX is using CentOS 7 as its Linux distribution. CentOS 7 has Postgres
9.2 included with its default repositories. Postgres 9.4 is required for SMaRT AFIX. The
following steps detail how to upgrade to Postgres 9.4.

Before continuing, it is assumed that you have already followed the Build a Linux
(CentOS) Server instructions.

1. Exclude the postgresqgl package from the CentOS base repositories - Edit
/etc/yum_repos.d/Cent0S-Base.repo and add the exclude lines below to the
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[base] and [updates] sections, then save the changes. Note that this must be
sudo'd to act as root to edit the file:

[base]

name=Cent0S-$releasever - Base
mirrorlist=http://mirrorlist.centos.org/?release=%$releaseveré&arch=$basearch&repo=
os&infra=$infra
#baseurl=http://mirror.centos.org/centos/$releasever/os/$basearch/

gpgcheck=1

gpgkey=Ffile:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-7

exclude=postgresgl™*

#released updates

[updates]

name=CentOS-$releasever - Updates
mirrorlist=http://mirrorlist.centos.org/?release=%$releaseveré&arch=$basearch&repo=
updates&infra=$infra
#baseurll=http://mirror.centos.org/centos/$releasever/updates/$basearch/
gpgcheck=1

gpgkey=Ffile:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-7

exclude=postgresgl*

2. Install the PGDG RPM file:

sudo yum install -y
https://download.postgresqgl -org/pub/repos/yum/9.4/redhat/rhel-7-
x86_64/pgdg-centos94-9.4-2 _noarch.rpm

3. Trigger the packages update:

sudo yum update

4. Install the Postgres 9.4 server/packages:

sudo yum install -y postgresql94-server postgresql94-libs

5. Initialize the Postgres database:

sudo Zusr/pgsql-9.4/bin/postgresql94-setup initdb

6. Set Postgres to run as a service and start Postgres:

sudo systemctl enable postgresql-9.4
sudo systemctl start postgresql-9.4

Modify Postgres Server Configuration Settings

Some of the Postgres server configuration settings must be modified.

1. Act as the postgres user to perform admin level changes:

sudo su - postgres
cd 9.4/data/
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Add the Postgres /bin/ directory to your path. Edit the ~/ _bash_profile and
add the following to the end of the file, then save the file:

PATH=/usr/pgsql-9.4/bin:$PATH
export PATH

Run the following to update the bash environment PATH:

source ~/_bash_profile

Edit postgres.conf with your favorite editor and add the following line right after
# - Connection Settings -, then save the file:

listen_addresses = "**

Edit the pg_hba.conf file to allow connections from other STC
servers/applications and secure the connection using md5 instead of clear text
passwords. Change the following line:

host all all 127.0.0.1/32 md5

to something like the following, which will enforce md5-encrypted password
communication. Let's assume your internal sub-net falls under 192.168.x.x, which
would update the line to:

host all all 192.168.0.0/16 md5

Save the changes. If you are technical and familiar enough with CIDR notation,
you can further customize and restrict connection access as needed.

Trigger Postgres to reload with the new configuration changes by running:

pg_ctl restart

Complete the installation by initializing the database (see SMaRT AFIX Database
Initialization - Linux).

Add Fuzzy Search Module to Postgres DB

In independent deployments of SMaRT AFIX, provider data is pulled from the SMaRT
AFIX Postgres database. This requires that an additional plugin be added to the database
to enable fuzzy searching.

1.

2.

Log in to the database server (dbb) as a root user:

sudo su - root

Install the contrib package:
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yum install postgresql-contrib

3. Enter "Y" when prompted.

4. Switch to postgres user:

sudo su - postgres

5. Log in to afixdb and create an extension for the fuzzy search:
psql -d afixdb

afixdb=# create extension fuzzystrmatch;
CREATE EXTENSION

SMaRT AFIX Database Initialization - Linux

The information below describes how to initialize the database for the first time, how to
upgrade/migrate an existing database, and how to set up daily jobs.

Prerequisite Tasks

Perform the following tasks before initializing the database:

1. Confirm that PostgreSQL has been installed.

2. Download the release distribution zip file from /7DBB/POSTGRES and extract the
database scripts for the database server.

3. As a root user, give read, write, and execute permissions on the flyway command
- Navigate to the /DBB/POSTGRES directory and execute this command:

cd /DBB/POSTGRES/
chmod 755 flyway

4. As a root user, install the dos2unix package:

yum install dos2unix

5. As a Postgres user, run the dos2unix command for the flyway file to make it
compatible for Linux - Navigate to the /DBB/POSTGRES directory and execute this
command:

cd /DBB/POSTGRES/
dos2unix flyway

Initialize a New Database (for the First Time Only)

If this is the first time you are initializing the database, follow the steps below.
Otherwise, see the Upgrade/Migrate an Existing Database instructions.
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1. Act as the postgres user:

sudo su - postgres

2. Prepare the tablespace by creating the directories that will be used by afixdb:

mkdir -p /var/lib/pgsql/9.4/afixdb
mkdir -p /var/lib/pgsql/9.4/afixdb/data
mkdir -p /var/lib/pgsql/9.4/afixdb/olapdata

3. Add postgres to your path:

export PATH=$PATH:/usr/pgsql-9.4/bin

4. Create the afixdb by navigating to the /DBB/POSTGRES directory and executing
this command:

cd /DBB/POSTGRES/
psql -a -f setup_database.sql

5. Create the database users and roles:

psql -d afixdb -a -f setup_objects.sql

6. Create the APP configuration schema:

./flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -
sqlMigrationPrefix=APP_V -user=afix migrate

7. Create the ODS schema:

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -
sqlMigrationPrefix=0DS_V -user=afix migrate

8. Create the OLAP schema:

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -
sqlMigrationPrefix=0LAP_V -user=afix migrate

Upgrade/Migrate an Existing Database

If this is not the first time you are initializing the database, follow the steps below.
Otherwise, see the Initialize a New Database (for the First Time Only) instructions.

1. Act as the postgres user:

sudo su - postgres

2. Migrate the APP configuration schema:
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3.

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -
sqlMigrationPrefix=APP_V -user=afix migrate

Migrate the ODS schema:

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -
sqlMigrationPrefix=0DS_V -user=afix migrate

4. Migrate the OLAP schema:

-/flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -
sqlMigrationPrefix=0LAP_V -user=afix migrate

Set Up a Daily Job / Drop Partition

1.

2.

Copy partition.sgl from the /DBB/POSTGRES directory to
/var/lib/pgsql/9.4/afixdb:

cp partition.sql /var/lib/pgsql/9.4/afixdb

Add a crontab entry to run the partition script daily at 1:00 a.m. to create future
partitions and drop old partitions:

[postgres@interop-qa0-dbb ~]$ crontab -e

#Add below 2 entries and save it (Esc + Shift + : + wq + Enter)
LOGFILE_AFIXDB=/var/lib/pgsql/9.4/afixdb/partition.log

01***echo "--———-————————— " >> $LOGFILE_AFIXDB ;
date >> $LOGFILE_AFIXDB ; psql -d afixdb -U postgres -f
/var/lib/pgsql/9.4/afixdb/partition.sql &&gt;> $LOGFILE_AFIXDB

SMaRT AFIX Database Initialization - RDS

The information below describes how to initialize the database for the first time, how to
upgrade/migrate an existing database, and how to set up daily jobs.

Prerequisite Tasks

Perform the following tasks before initializing the database:

1.
2.

Confirm that PostgreSQL has been installed.

Download the release distribution zip file from /DBB/POSTGRES and extract the
database scripts for the database server.

As a root user, give read, write, and execute permissions on the flyway command
- Navigate to the /DBB/POSTGRES directory and execute this command:

cd /DBB/POSTGRES/
chmod 755 flyway
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4. As a root user, install the dos2unix package:

yum install dos2unix

5. As a Postgres user, run the dos2unix command for the flyway file to make it
compatible for Linux - Navigate to the /DBB/POSTGRES directory and execute this
command:

cd /DBB/POSTGRES/
dos2unix flyway

Initialize a New Database (for the First Time Only)

If this is the first time you are initializing the database, follow the steps below.
Otherwise, see the Upgrade/Migrate an Existing Database instructions.

1. Add postgres to your path:

export PATH=$PATH:/usr/pgsql-9.4/bin

2. Create the afixdb by navigating to the Zusr/pgsql-9.4/bin directory and
executing this command. Enter the password at the end.

cd /usr/pgsql-9.4/bin
psql -h <rds_hostname> -d <default_db_created_with_RDS> -p <DB port> -u
<RDS-superuser> -f /DBB/POSTGRES/setup_database_ Rds.sql

3. Create the database users and roles:

cd /usr/pgsql-9.4/bin
psgl -u <rds_hostname> -d afixdb -p <DB_port> -u <RDS-superuser> -f
/DBB/PSTGRES/setup_objects.sql

4. Create the APP configuration schema:

-/flyway -url=jdbc:postgresql ://<RDS-hostname>:5432/afixdb -schemas=app
-sqglIMigrationPrefix=APP_V -user=afix migrate

5. Create the ODS schema:

-/flyway -url=jdbc:postgresql ://<RDS-hostname>:5432/afixdb -schemas=ods
-sqglIMigrationPrefix=0DS_V -user=afix migrate

6. Create the OLAP schema:

-/flyway -url=jdbc:postgresql://<RDS-hostname>:5432/afixdb -schemas=olap
-sqglIMigrationPrefix=0LAP_V -user=afix migrate

7. Create the .pgpass file under the home directory (usually root):
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vi ~/.pgpass

8. Add these contents into the .pgpass file and save it:

<RDS_hostname>:<port>:<database>:<username>:<password>

Upgrade/Migrate an Existing Database

If this is not the first time you are initializing the database, follow the steps below.
Otherwise, see the Initialize a New Database (for the First Time Only) instructions.

1. Act as the postgres user:

sudo su - postgres

2. Migrate the APP configuration schema:

-/flyway -url=jdbc:postgresql://<RDS-hostname>t:5432/afixdb -schemas=app
-sqglMigrationPrefix=APP_V -user=afix migrate

3. Migrate the ODS schema:

-/flyway -url=jdbc:postgresql ://<RDS-hostname>:5432/afixdb -schemas=ods
-sqglIMigrationPrefix=0DS_V -user=afix migrate

4. Migrate the OLAP schema:

-/flyway -url=jdbc:postgresql://<RDS-hostname>:5432/afixdb -schemas=olap
-sqglIMigrationPrefix=0LAP_V -user=afix migrate

Set Up a Daily Job / Drop Partition

1. Copy partition.sql from the /DBB/POSTGRES directory to Zopt/partitionDir:

cp partition.sql /opt/partitionDir
chmod 755 /opt/partitionDir/partition.sql

2. Add a crontab entry to run the partition script daily at 1:00 a.m. to create future
partitions and drop old partitions:

[postgres@interop-qa0-dbb ~]$ crontab -e
#Add below 2 entries and save it (Esc + Shift + : + wq + Enter)

LOGFILE_AFIXDB=/opt/partitionDir/partition.log
01***echo "--———————-——-——-- " >> $LOGFILE_AFIXDB ;

date >> $LOGFILE_AFIXDB ; cd Zusr/psql-9.4/bin ; psql -d afixdb -h <RDS-
hostname> -U <username> -f /opt/partitionDir/partition.sql &>>
$LOGFILE_AFI1XDB
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SMaRT AFIX Database Migration from EC2
Postgres to RDS

The following instructions explain how to perform a database migration from EC2
Postgres to RDS.

Prerequisite Tasks
Perform the following tasks before initializing the database:

1. Confirm that the PostgreSQL client (Psql) has been installed.

2. Download the release distribution zip file from /7DBB/POSTGRES and extract the
database scripts for the database server.

3. As a root user, give read, write, and execute permissions on the flyway command
- Navigate to the /DBB/POSTGRES directory and execute this command:

cd /DBB/POSTGRES/
chmod 755 flyway

4. As a root user, install the dos2unix package:

yum install dos2unix

5. As a Postgres user, run the dos2unix command for the flyway file to make it
compatible for Linux - Navigate to the /DBB/POSTGRES directory and execute this
command:

cd /DBB/POSTGRES/
dos2unix flyway

Create Dump File from Postgres

Use these instructions to create a dump file from Postgres installed in the EC2 instance:

1. Log in as a Postgres user and create a dump file using this command:

su - postgres
pg_dump dbname=afixdb -f myafixdump.sql

2. Save this SQL file (myafixdump.sqgl) into the most convenient directory.

Initialize a New Database (for the First Time Only)

Follow these steps to initialize the new database for the first time only:

1. Add postgres to your path:
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export PATH=$PATH:/usr/pgsql-9.4/bin

2. Create the afixdb by navigating to the /Zusr/pgsql-9.4/bin directory and
executing this command. Enter the password at the end.

cd /usr/pgsql-9.4/bin
psql -h <rds_hostname> -d <default_db_created_with_RDS> -p <DB port> -U
<RDS-superuser> -f /DBB/POSTGRES/setup_database_ Rds.sql

3. Create the database users and roles:

cd /usr/pgsql-9.4/bin
psql -u <rds_hostname> -d afixdb -p <DB_port> -u <RDS-superuser> -f
/DBB/PSTGRES/setup_objects_Rds_Migration_From_Ec2.sql

4. Restore the dump file created in the previous section into the RDS console using
this command:

cd /usr/pgsql-9.4/bin
psql -h <rds_hostname> -p <DB_port> -U <RDS-superuser> -d afixdb -f
/var/lib/gsql/myafixdump.sql

5. Create the APP configuration schema:

-/Flyway -url=jdbc:postgresql://<RDS-hostname>:5432/afixdb -schemas=app
-sqglIMigrationPrefix=APP_V -user=afix migrate

6. Create the ODS schema:

-/Flyway -url=jdbc:postgresql://<RDS-hostname>:5432/afixdb -schemas=ods
-sqglIMigrationPrefix=0DS_V -user=afix migrate

7. Create the OLAP schema:

-/flyway -url=jdbc:postgresql://<RDS-hostname>:5432/afixdb -schemas=olap
-sqlIMigrationPrefix=0LAP_V -user=afix migrate

8. Create the .pgpass file under the home directory (usually root):

vi ~/._pgpass

9. Add these contents into the .pgpass file and save it:

<RDS_hostname>:<port>:<database>:<username>:<password>

Set Up a Daily Job / Drop Partition

1. Copy partition.sql from the /DBB/POSTGRES directory to Zopt/partitionDir:

cp partition.sql Zopt/partitionDir
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chmod 755 /opt/partitionDir/partition.sql

2. Add a crontab entry to run the partition script daily at 1:00 a.m. to create future
partitions and drop old partitions:

[postgres@interop-qa0-dbb ~]$ crontab -e

#Add below 2 entries and save it (Esc + Shift + : + wq + Enter)
LOGFILE_AFIXDB=/opt/partitionDir/partition.log

01***echo "--———————-——-——-- " >> $LOGFILE_AFIXDB ;
date >> $LOGFILE_AFIXDB ; cd /usr/psql-9.4/bin ; psql -d afixdb -h <RDS-
hostname> -U <username> -f /opt/partitionDir/partition.sql &>>
$LOGFILE_AFIXDB

SMaRT AFIX Online Tool Web Service
Installation - LiInux

The SMaRT AFIX Online Tool web service is used by the SMaRT AFIX application to
generate an XML file to be uploaded to the CDC's AFIX online tool application. The web
service is a simple web application that is installed alongside the Stand Alone Forecaster
on the Service machine (SVC).

Prerequisites

The Postgres database is installed and configured.
The Postgres password for the SMaRT AFIX database is known.
The Tomcat instance is installed on the SVC server.

All necessary ports are open across all firewalls.

a rp 0N PR

The release distribution file for the SMaRT AFIX Online Tool web service is
extracted from /SVC/ONLINE_TOOL/afix.export.ws.war and copied to your local
drive.

Installation Steps

1. Copy the afix.export.ws.war file to your Tomcat webapps folder
($CATALINA_HOME is your Tomcat installation directory):

$ cp afix.export.ws.war $CATALINA_HOME/webapps/afix.export.ws.war

2. Restart Tomcat.

3. Update the application properties to point to the proper Postgres database. Make
sure the username and password are correct.

4. Edit the $CATALINA_HOME/webapps/afix.export.ws/WEB-INF/app.properties
file:
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driverClassName=org.postgresql .Driver
url=jdbc:postgresql://127.0.0.1:5432/afixdb
username=afixUser

password=afixPassword

5. Restart Tomcat.

6. Verify the installation with this command. Note that you may need to adjust the
port from 8080, depending on your Tomcat configuration.

curl -XGET
"http://localhost:8080/afix.export.ws/api/vl/sitevisit/?org_id=
0&fac_id=0&cohort=All" -H "API-KEY: 123456" -H "accept:application/xml"

7. Verify that you have the following result:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<AFIXExport xsi:schemaLocation="http://www.cdc.gov/afix/online-
tool/1.1/exportSchema CDC_AFIX_Export.xsd"
xmlns="http://www.cdc.gov/afix/online-tool/1.1/exportSchema"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"'>

<Header>

<AwardeeName>No Provider Found</AwardeeName>

</Header>

</AFIXExport>

Jaspersoft ETL Installation - Linux

Follow these instructions to install Jaspersoft ETL, Apache Web Server, and Subversion,
and to configure the administration console. This installation only needs to occur once.

Prerequisites

1. Java JDK 8 (1.8.91) has been installed.

2. The environment variables JAVA HOME, JDK_HOME, and PATH have been set.
Example:

export JAVA HOME=/usr/lib/jvm/jdk1.8 91
export JDK_HOME=/usr/lib/jvm/jdkl1.8 91
export PATH=$JAVA_ HOME/bin:$PATH

export PATH=$JDK_HOME/bin:$PATH

3. Copy the components from the distribution /Server Components/ETL directory
into your local directory. These files include:
e license.txt

e TIBCOJaspersoft-JETL-Installer-20150908...zip

o etl.zip
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Install Jaspersoft ETL

1.

10.
11.
12.

13.

Download the Jaspersoft ETL installer zip file:

Server Components/ETL/TIBCOJaspersoft-JETL-Installer-20150908 1633-
V6.0.1-installer.zip

Place the installer into the installation directory:

/opt/TIBCOJaspersoft-JETL-Installer-20150908_1633-V6.0.1-installer.zip

Navigate to the installation directory:

$ cd /opt

Install the Unzip utility if it is not already present:

$ sudo yum install zip unzip -y

Unzip the installer:

$ sudo unzip TIBCOJaspersoft-JETL-Installer-20150908_1633-V6.0.1-
installer.zip

Set the execute permission on the installer:

$ sudo chmod +x TIBCOJaspersoft-JETL-Installer-20150908 1633-V6.0.1-
linux64-installer.run

Execute the installer:

$ sudo ./TIBCOJaspersoft-JETL-Installer-20150908_1633-V6.0.1-1inux64-
installer._run

Follow the prompts to accept the license agreement.

Follow the prompts to specify the installation folder. Specify the
/opt/TIBCOJaspersoft-6.0.1 directory.

Follow the prompts to select the install style of item 1 (Easy).

Follow the prompts to select the install type of item 1 (Server).

Follow the prompts to select the license file (provide the location of the license

file).

Wait until the installation completes.
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Start/Stop Jaspersoft ETL Services
The following are the instructions to start and/or stop Jaspersoft ETL services. These

steps are not mandatory on a first-time installation because the services will be running
by default.

Start/Stop Jaspersoft ETL Admin Console

Command to stop the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/jac
$ sudo ./stop_tac.sh

Command to start the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/jac
$ sudo ./start_tac.sh

Start/Stop Jaspersoft ETL Command Line

Command to stop the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/cmdline
$ sudo ./stop_cmdline.sh

Command to start the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/cmdline
$ sudo ./start_cmdline.sh

Start/Stop Jaspersoft ETL Job Server

Command to stop the service:
$ cd /opt/TIBCOJaspersoft-6.0.1/jobserver
$ sudo ./stop_jobserver.sh

Command to start the service:

$ cd /opt/TIBCOJaspersoft-6.0.1/jobserver
$ sudo ./start_jobserver.sh

Auto Start/Stop Jaspersoft ETL Services

Follow these instructions to automatically start and/or stop Jaspersoft ETL services.
Note: These steps are not mandatory for a first-time installation because the services
run by default.

Create New User

Use this command to create a new user:
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$ sudo adduser talenduser

Assign ownership of Zetl and Zopt/TIBCOJaspersoft-6.0.1 to the new user created
above:

$ sudo chown -R talenduser:talenduser /etl
$ sudo chown -R talenduser:talenduser /opt/TIBCOJaspersoft-6.0.1

Edit Startup Scripts

Follow these steps to edit the startup scripts.

1. Copy these scripts from the package folder DBB/ETL/Autostart into a convenient
directory:

e jJaspersoft-cmdline-6.0.1
e jJaspersoft-jac-6.0.1
e jJaspersoft-rjs-6.0.1
2. Copy the above files into the Zetc/init.d directory.
3. Edit all three scripts and modify the environment variables as shown here:
;sz:pl)ort JAVA_HOME=[Path for JAVA HOME directory. This should be Oracle

* RUN_AS_USER=talenduser [If you are running as a root user, comment out
this statement.]

4. Edit the chkconfig setting to start the script on system reboot:

* chkconfig --level 235 jaspersoft-jac-6.0.1 on
* chkconfig --level 235 jaspersoft-rjs-6.0.1 on
* chkconfig --level 235 jaspersoft-cmdline-6.0.1 on

Configure the Admin Console

These steps are used one time only. They should be completed during the server
installation.

1. Navigate to http://[host name]:8080/0rg. jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Navigate to User Settings on the left menu and update the username (if
needed) and library information.
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3. Click on Role and select all of the roles.

Roles Selection X

Role
Administrator
WViewer

Operation manager
Designer

4. Navigate to Project settings from the left menu and add a new project by
clicking the Add button.
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5. Name the project as AFIX_ETL, select the Active option, enter AFIX_ETL as the
description and admin admin as the Author, select None as the storage, and
save it.

Project

Label:
Active:
Reference:
Description:
Author:

Storage:

6. Navigate to Project authorization from the left menu. Click on each of the
newly created projects and assign read/write permissions to the user.

User Authorizations for the Project: AFIX_ETL

Authorizations by Project Authorizations by User

Project User Authorizations for the Project: AFIX_ETL

Project ... Label 8 & Type Login Lastname Firstna... Active
ki admin@stchome.com admin admin [~]

7. Create the following directories and files in the server:

sudo mkdir /Zopt/TIBCOJaspersoft-6.0.1/deploy

sudo mkdir /Zopt/TIBCOJaspersoft-6.0.1/deploy/generatedJobs
sudo mkdir /Zopt/TIBCOJaspersoft-6.0.1/deploy/executionlLogs
sudo mkdir /Zopt/TIBCOJaspersoft-6.0.1/cmdline/exports

sudo mkdir /opt/TIBCOJaspersoft-6.0.1/Audit

sudo mkdir /Zopt/TIBCOJaspersoft-6.0.1/Audit/reports

sudo mkdir /opt/TIBCOJaspersoft-6.0.1/joblogs

sudo touch /opt/TIBCOJaspersoft-6.0.1/joblogs/log

8. In Primary Command Line configuration, set the path for the Job generation folder
to /opt/TIBCOJaspersoft-6.0_.1/cmdline/exports
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Host: localhost @
Port: 8002 ©
Job generation folder: lopt/TIBCOJaspersoft-6.0.1/cmdline/exports @ validity of path cannot be checked
User component path: @ validity of path cannot be checked
Version £.0.1.20150908_1633 ®

9. In Job Conductor configuration, set the path for the Generated jobs folder to
/opt/TIBCOJaspersoft-6.0.1/deploy/generatedJobs and the path to the Tasks
logs folder to Zopt/TIBCOJaspersof-6.0.1/deploy/executionlLogs

= Job Conductor (7 Parameters ©

lGenerated jobs folder: lopt/TIBCO) aspersofi-6.0.1/deploy/generated Jobs (]

Tasks logs folder: lopt/TIBCOJaspersoft-6.0.1/deploy/executionLogs @

Mumber of executions log: 1000 @

Maximum age of log file(d): 0 ©

Maximum number of generated 3 ©

abs:

Maximum age of generated job(d): |0 ©

Duartz serviet @ Initialized

10. In Logging configuration, set the Technical log file path to

/opt/TIBCOJaspersoft-6.0.1/joblogs/log

[—_I Loeging (4 Farameters [ 1errors w
Technical log file path: 'opt/TIBCOJaspersoft-6.0.1/joblogs/log e
Technical log threshold: WARN v @
Business log file path: (V]

11. In Audit configuration, set the Reports stored path to Zopt/TIBCOJaspersoft-
6.0.1/Audit/reports
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I= Audit (6 Parameters ()

url: jdbc:h2:/opt/TIBCOJaspersoft-6.0.1/jac/apache-tomce
User: tisadmin
Password: =
Driver: org.h2.Driver v
Web Console http://52.33.215.54:8080/org. jaspersoft.administra

tor/h2console

Reports stored path: lopt/TIBCOJaspersoft-6.0.1/Audit/reports

©0 000

©

12. Navigate to Servers page from the menu and create a new execution sever with

the following settings:
e Label: Name of the job server
e Host: ETL Server IP (it usually ends with dbb)
e Command port: 8000
e File transfer port: 8001
e Monitoring port: 8888
e Active: Select this option (enable)
e Username: the admin username for the ETL

e Password: the password for the admin ETL user

Execution server
Label: qal-etl
Description:
Haost: 10.0.5.137
Time zone: y
Command port: |8000
File transfer EDO1
port:
Maonitoring port: |&a82
Timeout on 120
unknown state
(s):
Username: admin@stchome.com
Password: B e
Use S5L:
Active:
Jaspersoft Runtime
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13. Log in via SSH to the Unix server using the ETL server owner.

14. Copy the etl.zip file (from /DBB/ETL) to a location convenient for you on the
ETL Jaspersoft server to unzip the file, such as a home directory.

15. Unzip the etl _zip file to the server in the root directory (Unix), which creates a
directory structure similar to this:

e Jetl
e /etl/data

e /etl/archive

SMaRT AFIX Jaspersoft ETL Deployment -
Linux

The following outlines how to import (migrate) Jaspersoft ETL for SMaRT AFIX.

Pre-Migration Checklist

e Confirm that the Postgres database is installed and configured
o Retrieve the passwords for the SMaRT AFIX database (afixdb)
e Retrieve the Jaspersoft ETL admin username and password

e Confirm that port 8080 is open across all firewalls

o Confirm that all of the steps in the Admin Console configuration are completed on
a first-time installation

e Copy these components from /DBB/ETL into your local directory:

API_Vaildation_Sequential_Execution_0.1
etl

Forecaster_Sequential_Execution_0.1
ODS_Sequential_Execution_0.1
OLAP_Sequential_Execution_0.1
AFIX_Assessment_Benchmark_ 0.1
LoadVFCEligibleStatus_ OnDemand_0.1
IWeb_User_API_Sequential_Execution_0.1

e ldentify whether the installation is an upgrade from prior versions or a fresh
installation from scratch.

New Installation Instructions (for the First Time Only)

If this is the first time you deploying Jaspersoft ETL, follow the steps below. Otherwise,
see the Upgrade Instructions.
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The steps below only need to be performed once. They should be completed during the
server installation.

Configure the Admin Console

1.

SMaRT AFIX (v. March 2018) Installation Guide

Navigate to http://[host name]:8080/0rg. jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email

notifications on ETL job failure (example: email_group@yourdomain.com).

Navigate to Project settings from the left menu and add a new project by
clicking the Add button.

Name the new project AFIX_ETL. Select the Active option, enter admin admin
as the Author, and select SVN as the Storage.

Project

Label:
Active:
Reference:
Description:
Author:

Storage:

Navigate to Project authorization from the left menu. Click on the newly
created project and assign read/write permission to the user.

Type Login Last name Firstna.. Active Right

W admin@stchome.com admin admin [~] &

Navigate to Servers page from the menu and create a new execution server with
the following settings:

e Label: AFIX_jobServer
e Host: ETL Server IP (it usually ends with dbb)
e Command port: 8000

e File transfer port: 8001
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e Monitoring port: 83888

e Active: Select this option (enable)
e Username: the admin username for the ETL

e Password: the password for the admin ETL user

Execution server

Label:
Description:
Host:

Time zone:

Command port:

File transfer
port:

Monitoring port:

Timeout on
unknown state

Is):
Username:
Password:
Use 55L:

Active:

qab-etl

10.0.5.137

B

admin@stchome.com

L T T R R R R PP T P

Jaspersoft Runtime

6. Log in via SSH to the Unix server using the ETL server owner.

7. Copy the etl ._zip file (from /DBB/ETL) to a location convenient for you on the

ETL Jaspersoft server to unzip the file, such as a home directory.

8. Unzip the etl.zip file to the server in the root directory (Unix), which creates a
directory structure similar to this:

e /etl/afix

o /etl/afix/api

e /etl/afix/archive

e /etl/afix/bulkload

e /etl/afix/dataout
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e /etl/afix/input
o /etl/afix/rejects
e Jetl/afix/tmp

e /etl/afix/validation

Deploy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.

2. Copy the following files from the installation files to a convenient location to
deploy:

e IWEB_Staging_Sequential_Execution.zip

e APl _Validation_Sequential Execution.zip

e ODS_Sequential_Execution.zip

e Forecaster_Sequential_Execution_0.1.zip

e OLAP_Sequential_Execution.zip

e AFIX_Assesment_Benchmark.zip

e LoadVFCEligibleStatus_OnDemand_0.1

e IWeb User_ API_Sequential Execution_0.1
3. Navigate to the Job Conductor page.

4. Select Add = Normal Task and add the following: Label = AFIX IWEB API
Execution; Description = AFIX IWEB APl Execution.

5. Click Import Generated Jobs and select the
IWEB_Staging_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

6. Click Save.

7. Select Add = Normal Task and add the following: Label = AFIX IWEB API
Validation; Description = AFIX IWEB API Validation.

8. Click Import Generated Jobs and select the
AP1_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

9. Click Save.

10. Select Add = Normal Task and add the following: Label = AFIX Stage 2 ODS
Load; Description = AFIX Stage 2 ODS Load.
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11.

12.
13.

14.

15.
16.

17.

18.
19.

20.

21.
22.

23.

24.
25.

26.

Click Import Generated Jobs and select the

ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add > Normal Task and add the following: Label = AFIX Forecast
Execution; Description = AFIX Forecast Execution.

Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.

Select Add = Normal Task and add the following: Label = AFIX OLAP Execution;
Description = AFIX OLAP Execution.

Click Import Generated Jobs and select the

OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add > Normal Task and add the following: Label = AFIX Assessment
Benchmark; Description = AFIX Assessment Benchmark.

Click Import Generated Jobs and select the

AFIX_Assessment_Benchmark.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add = Normal Task and add the following: Label = Load VFC_Eligible;
Description = Load VFC Eligible.

Click Import Generated Jobs and select the
LoadVFCEligibleStatus_Ondemand.zip file downloaded as part of the prerequisites.
Add the following: Execution Server = AFIX_JobServer; On Unavailable JobServer
= Wait.

Click Save.

Select Add > Normal Task and add the following: Label = IWeb User API;
Description = IWeb User API.

Click Import Generated Jobs and select the
IWeb_User_API_Sequential_Execution_0.1 file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable Job Server = Wait.
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27. Click Save.

28. For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.

e Email_To
e Email_SMTP_Host
e Email_SMTP_Port
e AFIX_Email_Notification
e Email_Active
e Email_UserName
e Email_Password
e Web service related parameters (Forecaster):
e SOAP_ACTION
e ENDPOINT
e Database-related parameters:
e AFIX_DB - Login, Password, Port, Database, and Server
e Source_DB_Context - Login, Password, Port, Database, and Server
e RDS-related parameters for ODS_sequential_job
e Psql_Path - Path of the psql (by default, it is Zusr/pgsql-9.4/bin)

e Rds_Postgres - A boolean parameter; set it to True if the database is
RDS

e Windows_Execution_Environment - A boolean parameter; set it to
False; the ID of the ETL execution environment is UNIX.

29. Save when finished.
30. Initial load instructions:
¢ Run the AssessmentBenchmark task

e Go to the task AFIX IWeb API Execution. Add the two JVM parameters:
-Xms1024M and -Xmx15690M. Run the AFIX IWeb APl Execution task and
wait to see if it executes without issues. After it starts to make progress,
continue with the next item
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% Refresh & Add

Active JVM parameter Description
& -Xmsl024M o
& -Kmx15690M e

e Go to the task IWeb API Validation and add a file trigger with the
following values: Label = TriggerValidationAPI, Folder Path =
/etl/afix/dataout, File Mask = API_EXTRACT_Complete.tkn, Pollint(s) = 200

AddTIle Trigge
Add file trigger
Label: TriggerValidationAPI B

Description: TriggerValidationAP|

etl/afix/api

START_ETL_RUN.tkn

e Go to the task AFIX Stage 2 ODS Load and add a file trigger with these
values: Label = TriggerODSLoad, Folder Path = /etl/afix/dataout, File Mask
= API_VALIDATION_Complete.tkn, Pollint(s) = 200

Add file trigger

e Go to the task AFIX Forecast Execution and add a file trigger with the
following values: Label = TriggerForecast, Folder Path = /etl/afix/dataout,
File Mask = API_LOADS_TO_ODS_Complete.tkn, Pollint(s) = 200. Add the
JVM parameters -Xms1024M and -Xmx15690M
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add tile trigger

Go to the task AFI1X OLAP Execution and add a file trigger with the
following values: Label = TriggerOLAP, Folder Path = /etl/afix/dataout, File
Mask = Forecast_Loads_Complete.tkn, Pollint(s) = 200. Add the JVM

parameters -Xms1024M and Xmx15690M

Add file trigger

Label: TriggerOLAP
Description: TriggerOLAP
Pollint (s): 1800

Folder path: etl/afix/dataout

Forecast_lLoads_Complete.tkn

31. Once the initial loads have completed, the ODS and OLAP tables are populated.
Now the daily sequence can be scheduled. Go to the AFIX IWeb API Execution
task and add the Cron trigger Trigger_IWeb_API. Enter the following values and

save:

Timezone Strategy: TAC Time
Minutes: O

Hours: O

Days of Month: Leave blank
Months: 1,2,3,4,5,6,7,8,9,10,11,12
Days of the Week: 1,2,3,4,5,6,7

Years: leave blank
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Al Cron irigper

32. Go to the IWeb User API Execution task and add the Cron trigger
Trigger_IWeb_User_API. Enter the following values and save:

e Timezone Strategy: TAC Time

e Minutes: O

e Hours: O

e Days of Month: Leave blank

e Months: 1,2,3,4,5,6,7,8,9,10,11,12
e Days of the Week: 1,2,3,4,5,6,7

e Years: leave blank

Al Cron irigper

33. Turn on the notify/email feature. Important Note: SMTP needs to be configured
beforehand.

e Select Notifications from the left menu
e Click Add
e Select the Tasks category

e Select On task failed
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e Select Enabled

e Select Recipients to specify the user's email. It is better to create an
email group as a recipient so that notifications are sent to multiple people

e Select AFIX ETL Workflow
If the upgrade needs to be aborted for any reason, import the previously created backup.

Alternatively, redeploy the previous version of the content.

Upgrade Instructions

If this is not the first time you are deploying Jaspersoft ETL (i.e., it was deployed earlier),
follow the steps below. Otherwise, see the New Installation Instructions.

The steps below only need to be performed once. They should be completed during the
server installation.

Configure the Admin Console

1. Navigate to http://[host name]:8080/0rg. jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Log in via SSH to the Unix server using the ETL server owner.

3. Copy the etl._zip file (located at /DBB/ETL) to the Jaspersoft ETL server. Use a
location convenient for you to unzip the file, such as a home directory.

4. Unzip the etl.zip file to the server in the Unix root directory (Unix), which adds
the following files that were created as part of this release:

o /etl/afix

o /etl/afix/api

o /etl/afix/archive
o /etl/afix/bulkload
e /etl/afix/dataout
o /etl/afix/input

o /etl/afix/rejects

o /etl/afix/tmp

e /etl/afix/validation

Deploy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.
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2.

10.
11.

12.
13.
14.

15.
16.

Copy the following files from the installation files to a convenient location to
deploy:

e IWEB_Staging_Sequential_Execution.zip

e APl _Validation_Sequential Execution.zip

e ODS_Sequential_Execution.zip

e Forecaster_Sequential_Execution_0.1.zip

e OLAP_Sequential_Execution.zip

e AFIX_Assesment_Benchmark.zip

e LoadVFCEligibleStatus_OnDemand_0.1

e IWeb_User_ API_Sequential _Execution_0.1
Navigate to the Job Conductor page.
Navigate to the task AFIX Assessment Benchmark.

Click Import Generated Jobs and select the AFIX_Assessment_Benchmark.zip
file downloaded as part of the prerequisites. Add the following: Execution server
= AFIX_JobServer; On Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AFIX IWeb API Execution.

Click Import Generated Jobs and select the
IWEB_Staging_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AFIX IWeb API Validation.

Click Import Generated Jobs and select the
AP1_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AFIX Stage 2 ODS Load.

Click Import Generated Jobs and select the

ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Navigate to the task AFI1X Forecast Execution.
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17.

18.
19.
20.

21.
22.

23.

24.

25.

26.

Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AFI1X OLAP Execution.

Click Import Generated Jobs and select the

OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add = Normal Task and add the following; Label = Load VFC Eligible;
Description = Load VFC Eligible.

Click Import Generated Jobs and select the
LoadVFCEligibleStatus_Ondemand_0.1.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Select Add = Normal Task and add the following: Label = IWeb User API;
Description = IWeb User API.

Click Import Generated Jobs and select the
IWeb_User_APl_Sequential_Execution_0.1 file downloaded as part of the
prerequisites. Add the following: Execution Server = AFIX_JobServer; On
Unavailable JobServer = Wait.

For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.

e Email_To

e Email_SMTP_Host

e Email_SMTP_Port

e AFIX_Email_Notification
e Email_Active

e Email_UserName

e Email_Password

e Custom Date: Set to the current date +1. For example, if the current date
is 2017-03-06, the context value should be set to 2017-03-07.

e RDS-related parameters for ODS_sequential_job
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e Psqgl_Path - Path of the psqgl (by default, it is Zusr/pgsql-9.4/bin)

e Rds_Postgres - A boolean parameter; set it to True if the database is
RDS

e Windows_ Execution_Environment - A boolean parameter; set it to
False; the ID of the ETL execution environment is UNIX.

27. Save when finished.

28. Initial load instructions: Go to the task AFIX IWeb API Execution. Run the task
and wait to see if the job executes without any issues. Once it has made
progress, make sure each of these tasks is triggered and completes:

e |Web API Validation
e State 2 ODS Load

e [Forecast Execution
e OLAP Execution

29. Once the initial loads have completed, the ODS and OLAP tables are populated.
Now the daily sequence can be scheduled. Resume the CRON trigger
Trigger_IWeb_API. Go to the task OLAP_Sequential _Execution and change the
context parameter custom date to the original value in
OLAP_Sequential_Execution and save.

30. Go to the IWeb User API Execution task and add the Cron trigger
Trigger_IWeb_User_API. Enter the following values and save:

e Timezone Strategy: TAC Time

e Minutes: O

e Hours: 0

e Days of Month: Leave blank

e Months: 1,2,3,4,5,6,7,8,9,10,11,12
e Days of the Week: 1,2,3,4,5,6,7

e Years: leave blank

If the upgrade needs to be aborted for any reason, import the previously created backup.
Alternatively, redeploy the previous version of the content.
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JasperReports Server Installation - Linux

The following instructions explain how to install the JasperReports Server.

Prerequisites

Download all of the JasperReports Server contents from the distribution site. The JRS
folder contains the following files:

e applicationContext-externalAuth-oAuth

e applicationContext-security

e applicationContext-security-web

¢ InstallCert$SavingTrustManager.class

¢ InstallCert.class

e jasperreports-server-6.2.1-linux-x64-installer.exe
e jasperserver.license

e LatoFont

e stc-jaspersoft-oauth-0.0.1-SNAPSHOT

Installation Steps

1. Download the JasperReports Server installer from the release distribution:

/Server Components/JRS/jasperreports-server-6.2._1-1inux-x64-
installer._run

2. Place the JasperReports Server installer into the target directory:

/opt/jasperreports-server-6.2_1-linux-x64-installer.run

3. Navigate to the target directory:

$ cd /opt

4. Set the execute permissions for the JasperReports Server installer:

$ sudo chmod u+x ./jasperreports-server-6.2.1-linux-x64-installer.run

5. Run the installer:

$ sudo ./jasperreports-server-6.2.1-linux-x64-installer.run
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10.

11.

12.

13.

Follow the prompts to accept the license agreement.

Follow the prompts to select an install option. Select option 1 - Install All
Components and Samples.

Follow the prompts to specify the installation folder. Specify the following
directory:

/opt/jasperreports-server-6.2.1

When the installer completes, start the JasperReports Server (see Start/Stop the
JasperReports Server below).

Before continuing, you need to update a configuration file on the JasperReports
Server. Navigate to:

cd /opt/jasperreports-server-6.2.1/apache-tomcat/webapps/jasperserver-
pro/WEB-INF/classes/

Open jasperreports.properties for editing and add the following under the
section marked # Highcharts static export properties:

com. jJaspersoft. Jasperreports._highcharts.function._properties.allowed=true

It should look something like this:

Save the file and restart the JasperReports Server (see Start/Stop the
JasperReports Server below).

Validate the installation by logging in to the JasperReports Server console. Use
your browser to access the server. Replace <hostname> below with the name or
IP address of the server:

http://<hostname>:8080/jasperserver-pro
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14.Log in with the user ID of superuser and the default password of superuser.

TIBCY Jaspersoft’

Getting Started

What's new in Jaspersoft Version 67
washboarss
A sngic oo eavironment for creating visualtzabons, with & mash up of Reperts, Ad Hoc Views, and wob pages

Al New Jasperdabile Support:
A active coperte i Dbt from pout emeriphons o Lablet meth the lagsersbokile sp Need help logging Bn?

Expanded Multi-arganization Administration:
ew todls s manage atiributes, expont/imedrt, and scheduling scross multiple srginaations

Update the License File

Follow these steps to update the license file for the JasperReports server:

1. Copy the license file (Jasperserver.license) from the distribution site and move
it to your home directory using FTP or WinSCP.

2. Replace the license file in the JasperReports installation directory
(/opt/jasperreports-server-6.2.1/) with the license file from the above step,
overwriting the existing jasperserver.license file.

3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).

Increase the JasperReports Session Timeout Period

By default, the JasperReports timeout period is set to 20 minutes. However, the timeout
period should be reset to 32 minutes in order to match with Keycloak.

1. Open web.xml from the path Zopt/jasperreports-server-6.2.1/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/web . xml

2. Search for the property <session-timeout> under <session-config> and update
the value to 32. After this, the property and value should be similar to the image
below:
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3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).

Start/Stop the JasperReports Server
Use these commands to start and stop the JasperReports server.
Start

$ cd /opt/jasperreports-server-6.2.1
$ -/ctiscript.sh start

Stop

$ cd /opt/jasperreports-server-6.2.1
$ -/ctiscript.sh stop

JasperReports Configuration with Keycloak

A few configuration changes need to be made in order for JasperReports to be used with
Keycloak.

Prerequisite

Keycloak must be installed and set up, if the SSO-enabled version of IWeb and VOMS is
being used.
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file:

Key

[KEYCLOAK_URL]

JasperReports Server Modifications

1. Edit the following values in the applicationContext-externalAuth-oAuth.xml

XML Tag Name(s) Value

to Update
<authorization_locati
on=>
<token_location>

<userdetails_location
>

<logoutUrl>

URL of the Keycloak server.

Example: https://sso-dev.stchome.com/

[KEYCLOAK_REALM]

<authorization_locati
on>

<token_location>

<userdetails_location
>

<logoutUrl>

Keycloak realm that the client belongs to. This
value needs to be changed, along with
<keycloak_URL>.

In this example, the realm name is Dev-
Integration: https://sso-
dev.stchome.com/auth/realms/Dev-
Integration

[JASPERSERVER_URL]

<property
name="redirecturl">
<property
name="logoutUrl">

URL of the Jasper server. Example:
http://<server_name>:8080/jasperserver-
pro/oauth

[CLIENT_ID]

<property
name="client_id">

Client ID as set on Keycloak. Example:
<property name="client_id">
<value>jasper-aws-dev</value>

[CLIENT_SECRET]

<property
name="clientsecret">
<property
name="userdetails_s
ecret">

Credentials secret key generated by Keycloak.

State_ID

<property
name="state">

This is the global setting used to populate the
STATE_ID attribute in Jaspersoft. Example:

<bean id="oAuthUserDetailsService"
class="com.jaspersoft.jasperserver.ps.OAuth.OAut
hUserDetailsServicelmpl">

<property name="state">

<value>WA</value>

</property>

</bean>

Jaspersoft Roles

<bean
id="mtExternalUserS
etupProcessor"
class="com.jaspersoft
.Jasperserver.multiple
Tenancy.security.exte

All the Jaspersoft Roles are configured inside this
tag. If any new Jaspersoft Roles are needed, they
must be configured here. In the <entry> tag, the
key value should match with the client role defined
at the Keycloak end.

Currently, the following roles are configured:
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Key XML Tag Name(s) Value
to Update

rnalAuth.processors.
MTExternalUserSetup | 1. Administrator
Processor"
parent="abstractExte | 2. Superuser
rnalProcessor">

<property
name="organizationR
oleMap">

3. User Role

<map>
<!-- Example of
mapping customer
roles to JRS roles -->
<entry>

<key>
<value>ROLE_ADMIN
_EXTERNAL_ORGANI
ZATION</value>
</key=>

<value>ROLE_ADMIN
ISTRATOR</value>
</entry>

</map>

2. Copy the applicationContext-externalAuth-oAuth.xml file (edited in Step 1)
to <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB- INF.

3. Copy stc-jaspersoft-oauth-1.0.0.jar (available in the JRS distribution folder) to
<JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-

INF/1ib.

4. Create and save a backup of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-
security.xml file.

5. In <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-
INF/applicationContext-security.xml, replace the access value for the

method
com. jaspersoft. jasperserver.api.metadata.user._service.ProfileAttribut

eService.putProfileAttribute with ROLE _USER.

6. Save a backup copy of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-security-
web.xml file again and replace the constructor-arg value for
org.springframework.security.web.authentication.LoginUrlAuthenticationEntryPoin
t with Zoauth.

7. Add the SSL certificate used by Keycloak to the Java installation that Jaspersoft is
using. (By default, Java only knows about a small number of root certificates.) To
do this, follow these steps:
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a.

Copy InstallCert$SavingTrustManager.class and InstallCert.class
(both available in the STC Suite Distribution/Server Components/JRS
directory) to the <JASPERSERVER_DIR>/java/bin directory.

NOTE for sso-dev.stchome.com: This is only for Dev SSO SSL certificate
installation. This URL changes based on your server hostname of the
Keycloak/SSO server.

Go to the <JASPERSERVER_DIR>/java/bin directory and execute these
commands:

sudo ./java InstallCert sso-dev.stchome.com

sudo ./keytool -exportcert -alias sso-dev.stchome.com-1 -keystore
Jssecacerts -storepass changeit -file sso-dev.stchome.com.cer
sudo ./keytool -importcert -alias sso-dev.stchome.com -keystore
../lib/security/cacerts -storepass changeit -file sso-
dev.stchome.com.cer

8. Make database changes with the following commands. Jaspersoft stores all of its
metadata in the Postgres database. All of the user-based profile attributes are
stored in the jiprofileattribute table in Jaspersoft. By default, user attributes
support a character size of 200. In Step E below, the data type size is changed
from 200 to 1,000.

a.

b.

Navigate to the <Jasper Installation Directory>/postgres directory.

Run this command: sudo bin/psgl -U postgres -W (the password is
postgres).

Now you should see at the prompt: postgres=#

Enter this command to connect to the Jasperserver database in Postgres: \c
Jasperserver; (the password is postgres).

Execute this SQL alter script: ALTER TABLE jiprofileattribute ALTER
COLUMN attrvalue TYPE character varying(100000);

9. Restart the Jasper server and navigate to JasperUrl/oauth (see example). You

should now be redirected to Keycloak to log in. Example:
http://52.10.228.158:8080/jasperserver-pro/oauth

Steps to Debug Issues Related to
Keycloak/JasperReports Server Integration

If there are any issues with integrating Keycloak with Jasper, follow these suggestions

below.

Check the applicationContext-externalAuth-oAuth.xml File

Make sure that applicationContext-externalAuth-oAuth.xml is configured with the
correct Keycloak and Jasper server parameters and with the correct client_secret.
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Keycloak Mappers

Make sure that the Jasper client has the below mappers mapped correctly in Keycloak,
and check if the Org/fac List mapper contains the correct parameters. (Note that your

API-KEY and API-URI will differ from the image below.

Org/fac List

Protocaol

Name

Consent Required
Mapper Type
Token Claim Name

PI-KEY

API-URI

OFF

Response format

application/json ¥

e [

Name Category Type

org/fac list Token mapper Org/fac list

email Token mapper User Property
groups Token mapper Group Membership
username Token mapper User Property
realm roles Token mapper Realm Role List
roles Token mapper Client Role List
given name Token mapper User Property
family name Token mapper User Property

full name Token mapper User's full name

Validate the IWeb Web Service

Make sure that the IWeb web service URL is accessible. The output of this should

return the org/fac list. If there is an error, it needs to be fixed.
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Check the Whitelist Rules

If Jaspersoft is installed in an AWS environment, the outbound connection on port
8080 should be enabled for the IWeb server.

If Keycloak is installed in an AWS environment, the outbound connection on port 8080
should also be enabled for the IWeb server.

Check the Firewall Rules

If there are any special firewall rules preventing the Jasper and/or Keycloak servers
from accessing IWeb through port 8080, the need to be fixed so that the port is
enabled.

JasperReports Server Upgrade - Linux

These instructions are only required when deploying SMaRT AFIX for the first time or
when upgrading from a version of SMaRT AFIX older than 1.17.4. If you have already
deployed SMaRT AFIX 1.17.4, you should already have the web service plugin installed
on your JasperReports server and can skip these instructions.

As a part of SMaRT AFIX 1.17.4, the new SMaRT AFIX Online Tool web service was
introduced to help support the CDC's AFIX Online Tool application. In order to integrate
this tool with SMaRT AFIX, a plugin must be added to the existing JasperReports server.

Prerequisites

1. JasperReports server has been installed.

2. The web service plugin zip file has been downloaded to your application server
(APP) and the contents extracted. The unzipped folder is referenced as $WS_DS
from this point on.

/APP/JRS/webserviceds _v1.0 _3.zip

3. Locate your JasperReports server web application folder, which is referred to as
$IJRS_HOME from this point on. It is recommended that you back up this folder
before beginning the plugin installation.

/opt/jasperreports-server-6.2._1/apache-tomcat/webapps/jasperserver-pro

SMaRT AFIX (v. March 2018) Installation Guide Page 48



Plugin Installation Steps
The installation should be performed as root user.

1. Stop your web server running JasperReports server.

2. Open the folder $WS_DS/JRS/WEB-INF/bundles and copy the contents to
$JRS_HOME/WEB-INF/bundles/. Note that this should not overwrite any existing
files.

cd /$WS_DS/JIRS/WEB-INF/bundles/
cp * /$IRS_HOME/WEB_INF/bundles/

3. Open the folder $WS_DS/JRS/WEB-INF/1ib and copy the contents to
$JRS_HOME/WEB-INF/1ib/. Note that this should not overwrite any existing files.

cd /$WS_DS/JIRS/WEB-INF/lib/
cp * /$JIRS_HOME/WEB_INF/1ib/

4. Open the $WS_DS/JIRS/WEB- INF/ folder and copy the applicationContext-

WebServiceDataSource.xml file to $JRS_HOME/WEB-INF/. Note that this should
not overwrite any existing files.

cd /$WS_DS/JIRS/WEB-INF/
cp applicationContext-WebServiceDataSource.xml /$JRS HOME/WEB_INF/

5. Restart the web server running JasperReports server.

Validation Steps

Follow these steps to confirm that the plugin has been successfully installed:

1. Navigate to your JasperReports server admin console.
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2. Log in as an admin-level user.

TIBC® Jaspersoft” # Lbrary View~ Manage~ Create,

Home
+ Recently Viewed Items ~#== Data Sources Domains
CoverageRateReport_Adolescent Report Define connection to a database or other data Add structure to a data source for use in an
! source. View tutorial Ad Hoc view. View tuterial
CoverageRateReport_Childhood Report = . > = .
Create  View list Create View list
AFIX_Online_Tool Report
MissedOppList_Export Report
MissedOppList Report 4" . Ad Hoc Views £ Reports
InvalidDoseList_Export Report t Visualize your data for analysis and report A I - Create and format interactive reports from
creation. View tutorial W /G g existing Ad Hoc views. View tutorial
InvalidDoseList Report T aP o
Create  View list Create View list
FullList_Export Report
FullList Report
CoverageRateReport_Adolescent_Export Report Dashboards 4 A Admin
+] Combine related reports into custom f :\7 y Configure your server instance and manage
dashboard layouts. View tutorial - § - User settings.
v Popular Resources
Create View list View options
® How-to videos
® How-to articles
@® Online Learning Portal

3. Select Create > Data Source from the top menu.

L/ - \(\ﬂ \{ ﬁ \(’ E stchome / afix_reporting X @ TIBCO Jaspersoft: Home X _

<« C O ‘ (@ 52.37.156.46:8080/jasperserver-pro/flow.html?_flowld=homeFlow

22 Apps Google Apps STC Links IWeb Git Timesheets CR145 Citrix Ja

TIBC2 Jas pe FSth' # Library View~ Manage~ Create~

Home Ad Hoc View
Report
» Recently Viewed Items Dashboard Sd
CoverageRateReport_Adolescent Report Domain onng
CoverageRateReport_Childhood Report

Create Vi
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4. Confirm that Web Service Data Source is listed in the Type drop-down list.

b"- ™ "’_-\ E \ ¥ “{ & stchome / afix_reporting xYﬂ TIBCO Jaspersoft: Mew [ X

&« C 1t | ® Notsecure | 52.37.156.46:8080/jasperserver-pro/flow.html?_flowld =addDataSourceFlow&ParentH

E:: Apps Google Apps STC Links IWeb Git Timesheets CR145 Citnx JasperSoft KeyCloak

T|BC‘”.JaSperSOft' # Library View+ Manage~ Create~

New Data Source

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.

Type: Web Service Data Source v
AWS Data Source

Bean Data Source

Cassandra Data Source

Internal Diagnostic Data Source
none |JDBC Data Source

JNDI Data Source

MongoDB Data Source

Langua MongoDB JDBC Data Source

json Virtual Data Source

Web Service Data Source

FReguest Verb:

Auth Ty

post

Web Service URI:

SUperuser

Password:

Username:

SMaRT AFIX JasperReports Deployment -
Linux

The following outlines how to import (migrate) Jaspersoft Reports for SMaRT AFIX.
Pre-Migration Checklist

e Confirm that the Postgres database is installed and configured
o Retrieve the passwords for the SMaRT AFIX database (afixdb)
o Retrieve the Jaspersoft superuser username and password

e Confirm that the SMaRT AFIX Online Tool web service is installed
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e Confirm that all necessary ports are open across all firewalls (the default port is
80)

e Confirm that the release distribution zip file for Jasper Reports is extracted from
/APP/JRS/AFI1X_Reports-[version number].zip and copied to your local drive.

e Important: Be sure to update the JasperReports server by following the
instructions in SMaRT AFIX JasperReports Server Upgrade - Linux.

Procedure Steps

Follow these steps to deploy Jaspersoft Reports.

Export the Jaspersoft Repository for Backup

Export the repository by selecting Manage > Server Settings > Export (Export
Everything) in Jaspersoft. Save the file as a backup.

TI BC"JaSpe rsoft- # Library \iews Manage~ Create~

£ Settings Export
Log Settings
File Properties
Log Collectors
Export Data File Name (required):
Ad Hoc Settings )
export.zip
Ad Hoc Cache
OLAP Settings Export Options:
AWS Settings #| Export Everything
Server Attributes Roles and Users to Export
Restore Defaults Selected roles and users Users with selected roles Roles with selected users
Import Roles: Users:
® Export = | ‘ =
-
Resources to Export Assets to Export Events to Export
¥ Data Sources ¥ Sub-organizations Access Events
+ Domains + Dependencies Audit Events
¥ Ad Hoc Views ¥ Permissions Monitoring Events

Import the Content via the Portal

1. Log in to the Jaspersoft Bl Portal as the administrator user.

2. Navigate to Server Settings > Import.
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3. Import the AFIX_Reports-[version number].zip file.

4. Update the data source with the database connection information.

Import the Content via the Command Line

1. Confirm that JAVA_HOME is set and your path includes jre\bin or jdk\bin.

2. Change to the buildomatic directory on the JasperReports server:
C:\Jaspersoft\jasperreports-server-6.2.1\buildomatic

3. Execute the migrate command (adding in the correct version number): js-
import.sh --input-zip "AFIX_Reports-[version number].zip" --update --
skip-user-update --include-access-events --include-audit-events --
include-monitoring-events

4. Update the data source with the database connection information: From the left
menu, go to root > AFIX > Data Sources. Select AFIX_AWS, then click the
Edit tab. Specify your database connection properties for Host, Port, and
Password, then click Save.

TlBC"JaSperSOft' #A& Library View-s Manage~ Create~

£l Folders Repository

(Sl root Run Edit Copy Cut Paste Delete

Sjal AFIX
Es Name Description

il Adhoc Views

f#hal Dashboards

Data Sources

Tl Domains

@l Images
Bl Input Controls
(Bl Queries

[l Reports

5. Select AFIX_EXPORT, then click the Edit tab. This is the web service data source
linked to the SMaRT AFIX Online Tool web service.
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TIBC@'Jaspersoft' A& Library Views Manage, Create.

© Folders Repository
[zl root Run Edit Open Copy Cut Paste Delete
Sl AFIX e
-/ Name Description

(@l Adhoc Views
[:]\_q Bundles NEEXC AES

[:]._J Dashboards AFIX_EXPORT
£™ Data Sources

[:1__... Domains
[:]._._. Images
[_:]._;4 Input Controls

[:1_,, Queries

[+lul Reports

6. Leave the defaults for Auth Type, Language, and Request Verb. Update the web
service URI to point to your SMaRT AFIX Online Tool web service deployment.
Note that even though the Password field is populated, no password is present or
required; leave it as it is. Click Save when finished.
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Edit Data Source: AFIX_EXPORT

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.
Type:

Auth Type:

none

Language:

xml

Request Verb:

get

Web Service URI:

http://10.0.0.12:8080/afix.export.ws/

Password:

Username:

Validate the New Content

The following steps perform a spot check on the newly created content to validate it and
to check for any serious errors. It does not perform a full check of all possible issues and
should be followed up with a functional validation of the content.

1. Log on to the Jaspersoft Bl server as a user able to run a report. The user should
be able to log in successfully and see the subfolders under /root/AFIX (select

View > Repositories).
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Syl root

fFhal Adhoc Views
Bundles
Dashboards
Data Sources

Domains

Hy Hy Ey E B

Images
Input Controls

Queries

H) FHi1 E)

Reports

2. Validate that the user can execute and view a report as defined by their class or
organization membership: Select the report from
AFIX/Reports/AFIX_Online_Tool, select one report from any of the other sub-
directories of AFIX/Reports, and confirm that both reports execute successfully.

Restore the Previous Content (if Necessary)

If there are any uncorrectable issues and the release upgrade needs to be aborted, follow
these steps to revert to the previous content:

1. Using the backup exported at the beginning of these steps, import using the steps
above. Note that a re-import of the previous version of the content will also
achieve the same back-out.

2. Perform the validation steps listed above.

Node.js Installation - Linux
Follow these steps to install Node.js on Linux.

1. Create the user environment: A user needs to be created to run Node.js
applications. However, it is not recommended that Node.js applications be run as
a privileged user.

sudo adduser node

2. Become the node user:

sudo su - node
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3. To install Node.js for the previously created node user, Node Version Manager is
recommended. This allows for more flexible control over the environment and an
easier future upgrade path.

curl -o-
https://raw.githubusercontent.com/creationix/nvm/v0.32_1/install_sh |
bash

source ~/.bashrc

4. Install the required version of Node.js:

nvm install 6.9.1
nvm use 6.9.1
nvm alias default 6.9.1

5. Install the PM2 node process manager:

npm install -g pm2

SMaRT AFIX Application Installation
Instructions - Linux

The following instructions explain how to install the application, the Oracle Instant Client,
and Redis; how to configure the application dashboard and quick links; specific
configuration options; and information on standalone versus multiple application
deployment.

If you are upgrading from a previously installed version of SMaRT AFIX, you can skip
directly to the Install the Deployment Package section and continue from there.

Prerequisites
The following should already be installed and configured:
e Linux CentOS 7
e PostgreSQL server (DBB)
e Oracle server (COR)
e Node.js (APP)
e PM2 (APP)
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Installation and Deployment of SMaRT AFIX, iQ, and
VOMS

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, you only
need to install the Oracle Instant Client and Redis with the first application installation.
Once these are installed, for subsequent applications that are running on the same
server, you can skip down to the Install the Deployment Package section and continue
from there instead.

Install the Oracle Instant Client

1. Download and install the Oracle Instant Client (both basic and SDK). The _rpm
files can be found at http://www.oracle.com/technetwork/topics/linuxx86-64soft-
092277 .html. Install them with the RPM command.

2. Add the following to the users: .bashrc, .cshrc, and .zshrc, or use the default
per-interactive-shell startup file of the default shell of the user for which you want
to run the application. Optionally, instead of adding them on a per-user basis, the
following can be added to /Zetc/profile or /etc/profile.d/oracle.sh:

export OCl_LIB DIR=/usr/lib/oracle/12_1/client64/1ib
export OCl_INC _DIR=/usr/include/oracle/12.1/client64

3. Create a file in /etc/ld.so.conf.d/oracle.conf with the path to the Oracle
Instant Client libraries, which by default are as follows:

/usr/lib/oracle/12.1/client64/1ib

Install Redis
When installing Redis, make sure epel repo is enabled:

yum install redis
systemctl enable redis
systemctl start redis

Install the Deployment Package

Copy the provided zip/tar file to the target server. Extract the archive and change into
the parent of the directory where it was extracted.

Configure the Application Dashboard and Quick Links
If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, the steps

below only need to be completed the first time an application is installed. This file should
be saved for all subsequent installations.
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1. Download the apps. json file from the release distribution application components
shared folder.

2. Edit this file with a text editor and replace the placeholders DASHBOARD_ URL,
IWEB_URL, AFIX_URL, PHC-HUB_URL, 1Q_URL, and VOMS_URL (if applicable for
your installation) with their respective URLs.

3. Save this file and keep it handy as you will need to use it in the installation of iQ,
VOMS, and the SSO dashboard.

An example of one such configuration object in the JSON file is shown below. In most
cases, only the URL value needs to change:

{

"icon': "/static/public/img/STC - SmartAFIX.svg",

"id": "AFIX",

“name': "SMaRT AFIX",

“url': "https://afix.stchome.com ",

"description: "Utilized to make AFIX assessments efficient, standardized and
meaningful .*",

"hidelfUnavailable': true,

""accessRole': "Access_afix"

}

Copy this file to the following location:

<application_install_dir>/src/shared/helpers/appActions/

Configure the Reverse Proxy

A reverse proxy is recommended to provide access to the various products. This is not
explicitly required unless the products are running with the ENABLE_SSL option set to
true. However, this will generally be the case when the products are being run in
conjunction with IWeb on the same server. See the example Apache configurations at
package/docs/apache.

General Product Configuration Options

Once the package containing the products has been installed, there are some
configuration options that can be set depending on the environment. The majority of
these lie in package/process. json, which is simply a JSON configuration file for pm2.
The options listed in bold below need to be changed to match your environment. Other
options not in bold might not need to change, and in most cases can be the default
setting. Some options in the process. json file are not listed at all below; those options
should be left unchanged.

The options are as follows:

\Description

script Location of the startup script application. The path to the script
may need to be customized.
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Option

\Description

cwd The path to the application. May need to be customized.

PRODUCT The name of the product.

HOST The host name for the product.

APIHOST The host name of the product's respective API server (generally
localhost).

PORT The port for the product.

APIPORT The port for the product's APl server.

NODE_ENV This should always be production.

SAML_ISSUER

The SAML issuer (client) from Keycloak.

SAML_ENTRY_POINT

The SAML entry point from Keycloak.

JASPER_SERVER

The domain name of the JasperReports server.

REDIS_URL

The Redis URL used for storing client sessions.

REVERSE_PROXY

When configuring SMaRT AFIX with a reverse proxy, this should be
set to true.

ENABLE_SSL

When set to true, this enables HTTPS support. If REVERSE_PROXY
is set to true, this should be set to false even when the
environment is configured for HTTPS.

SECRET_SESSION

The secret key for session storage. IMPORTANT NOTE: This value
must be exactly the same for every application, in both the server
and the API environment variables.

SMaRT AFIX-Specific Configuration Options

The following options are specific to SMaRT AFIX configuration settings:

(@]e]ue]g]
VOMS_ORACLE_USER

Description \

The username for IWeb's SIIS database. This is set to the
default user for the SIIS, but may need to be updated
depending on your configuration.

VOMS_ORACLE_PASSWORD

The password for IWeb's SIIS database. This is set to the
default password for the SIIS, but may need to be updated
depending on your configuration.

VOMS_ORACLE_CONNECTION | Connection information for IWeb's SIIS database. This needs

to be updated to point to your IWeb's Oracle database
instance.

PG_USER

The user account for the SMaRT AFIX PostgreSQL database.

PG_PASSWORD

The password for the associated PG_USER for the SMaRT AFIX
PostgreSQL database.
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Option Description \

PG_HOST The hostname for the SMaRT AFIX PostgreSQL database.

PG_PORT The port number for the SMaRT AFIX PostgreSQL database.

AFIX_EXPORT_URI The URL for the SMaRT AFIX Online Tool web service. Only the
hostname and possibly the port number for the URL need to be
updated.

AFIX_EXPORT_KEY The API Key for the SMaRT AFIX Online Tool web service. This

should be left as the default.

CDSI_FORECASTER_VERSION | The current version of the CDSI Forecaster deployed. For the
SMaRT AFIX 1.17.5.4 release, it should be set to 5.17.10.

AP1_URL_PREFIX This should be set to Zapi

Standalone SMaRT AFIX vs. Multiple Application
Deployment

The SMaRT AFIX bundle you were provided contains an Org-Fac-Micro-Service include in
the process. json file that looks something like the example below. The same micro-
service is included in the process. json file for the iQ application. If you are deploying
SMaRT AFIX alongside iQ, this service should only be included in the process. json file
for the first application you deploy. It needs to be removed from the process. json file
for all other applications.

{

"name"* : "org-fac-micro-service",

“script" : "afix-pre-windows/services/bin/service.js",

""Iinstances" -2,

"exec_mode™ : "cluster”,

"cwd" : "afix-pre-windows/services",

“"env': {

""NODE_ENV™ : "production®,

"SERVICE" : "facilitySearch"”,

""SERVICE_PORT" - 3060,

""SAML_ ISSUER" : "dev-portal”,

"SAML_ENTRY_POINT"" : "https://sso-dev.stchome.com/auth/realms/Dev-
Integration/protocol/saml™,

"JASPER_SERVER" : "interop-aws-jaspersoft.stchome.com™,

"REDIS_URL™ : "redis://localhost:6379",{

""VOMS_ORACLE_USER" : "user",

""VOMS_ORACLE_PASSWORD™ : "password",

""VOMS_ORACLE_CONNECTION"" : "(DESCRIPTION = (ADDRESS = (PROTOCOL =
TCP)(HOST = 10.0.0.1)(PORT = 1521)) (CONNECT_DATA = (SID = SID)))",

}
3.

NOTE: Due to variations in the org-fac-micro-service between the different applications (SMaRT
AFIX, VOMS, and iQ), it is recommended that you deploy the service that is bundled with SMaRT
AFIX instead of the one bundled with other applications.
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Run the Application

Use pm2 to run the deployment package as shown below. In many cases, environment-
specific configuration options must be set prior to running an application's package. See
the configuration option sections above for more details.

pm2 start package-parent/process.json

Start the Products upon Bootup

To have the products automatically start on every boot, do the following once it has been
verified that they are running correctly:

pm2 save
pm2 startup
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wWindows Instructions

The following instructions are for the Windows operating system.

Forecaster Installation Instructions -
Windows

The installation of the Standalone Forecaster (SAF) is composed of three major tasks:
install Oracle Express, install the SAF database into Oracle Express, and install the
Forecaster web application into Tomcat. All three components are installed on the Service
machine (SVC).

SAF can be installed to Oracle 11g or Oracle Express 11g. The Oracle product you choose
will depend on your state's licensing. Oracle Express 119 is free to use for this type of
installation. All performance testing, etc., for SAF has been conducted using Oracle
Express. These instructions only cover the installation of Oracle Express 11g.

Install Oracle Express

1.
2.

If necessary, create an Oracle account at http://www.oracle.com.

If using Oracle Express (free), download the appropriate version. The Windows
version is approximately 312MB in size.

Unzip the downloaded file and run the DISK1/setup.exe. When using the
installation wizard, the installer creates a database named XE. The installer uses
these ports: TNS = 1521, MTS = 2030, HTTP = 8080.

There may be two error messages about a missing file named KEY_XE.reg. Just
acknowledge them and continue with the installation.

Disable the HTTP port by running the following at a command prompt after the
installation is complete:

echo EXEC DBMS_XDB.SETHTTPPORT(0); | sqlplus / as sysdba
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Part for 'Oracle HT TP Ligtener': 8080

Kl
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Install the SAF Database (New Installation)

Database objects are created with 5.16.9 CDSi install version.

1. Navigate to the
/SVC/0XE/db/AF1X_CDSI1_Install/AFIX _CDS1 v5.16.9 Install/ directory.

Run Install_bat.
Navigate to the /SVC/OXE/db/Patches/patch_v5_17_CDSI directory.
Run the forecast.bat script.

Navigate to the /SVC/OXE/db/Patches/patch_v5 18 CDSI directory.

o o M W N

Run the forecast.bat script.

Run Database Patches (Upgrades)

1. Navigate to the /SVC/0OXE/db/Patches/patch_v5_17_CDSI directory.

2. Run the forecast.bat script.
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Install the Web Application

Before installing the SMaRT AFIX web application, Java 7 must be installed on the SVC
server and Tomcat 7.0 must also be installed and running on the SVC server.

1. Edit the conf/context._xml file - Add the lines below (between the
<Context></Context> tags) to the CATALINA_ HOME/conf/context.xml file. The
added lines should be placed within the <Context></Context> tags in the file.

<Context>
<Resource name="jdbc/com/stc/forecaster"
auth="Container"
type=""javax.sql .DataSource™
driverClassName="oracle.jdbc.OracleDriver"
url="jdbc:oracle:thin:@localhost:1521/XE"
username=""SAFUSER""
password=""SAF"
maxActive="100"

maxlidle=""10"
maxWait=""-1"/>
</Context>

2. Copy the /SVC/SAF/forecaster.war to webapps/forecaster.war under your
Tomcat directory.

3. Restart Tomcat.

4. Set the number of threads to the number of processor cores available on your
server - Edit $CATALINA_HOME/webapps/forecaster/WEB- INF/spring-ws-
servlet._xml and set the thread count (see the second line of code below):

<bean id="forecastingEndpointl2"
class=""com.stchome.saf.ws.endpoint.ForecasterServiceEndpointl2"
scope="‘prototype'>

<constructor-arg value="1" /><l-- Thread count -->

<constructor-arg value="60" /><!-- Thread pool termination timeout in
seconds-->
</bean>

5. Restart Tomcat.

6. Verify the application is running correctly by navigating to http://[YOUR
SERVER]/forecaster. The Ul displays if the application was successfully installed
and configured.
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Postgres Database Installation - Windows

The information below describes how to install the Postgres database on Windows Server
2008 R2 64-bit, as well as how to modify relevant Postgres server configuration settings
for SMaRT AFIX.

Install on Windows
The following information covers general installation instructions for installing PostgreSQL

on Windows. Windows Server 2008 R2 64-bit was used as a reference, but installation on
other versions of Windows should be similar.

1. Visit this page and download the latest 64-bit version of Postgres. Version 9.4.x
was used for this installation example.
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2. Run the downloaded executable to start the installation. It is recommended to use
the default installation directories, but they can be customized as needed (make
note of the new locations).

3. Choose a password for the Postgres admin user postgres and store it securely for
when administrative maintenance is required.

4. Use the default port 5432 (recommended). An alternate port can be used, but
make sure to configure connecting applications to the Postgres database.

5. Use the default locale.

6. On the last step post installation, you can uncheck the Stack Builder may be...
option and click Finish.

Modify Postgres Server Configuration Settings

Some of the Postgres server configuration settings must be modified. If you used the
default installation directory, the following file reference locations should be located in
the directory path:

C:\Program Files\PostgreSQL\9.4\data\

1. Edit the pg_hba.conf file to allow connections from other STC
servers/applications. Copy/paste the following line:

host all all 127.0.0.1/32 md5

to make the file look something like the following. Let's assume your internal sub-
net falls under 192.168.x.x, which would update the line to:

host all all 127.0.0.1/32 md5
host all all 192.168.0.0/16 md5
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2. Save the changes. If you are technical and familiar enough with CIDR notation,
you can further customize and restrict connection access as needed.

3. Trigger Postgres to reload with the new configuration changes by running Reload
Configuration, found under PostgreSQL 9.4 in the Windows Start Menu:

; Maintenance

, PoskgresQL 9.4

$ Application Skack Builder
W patdmin 111
£ 3 Reload Confiquration

B S0l shell (psqgl)
, Documentation

| Skartup

4. Create a custom firewall rule to allow inbound connections on port 5432:

Postgresqgl Properties .

| General I Programs and Services | Remote Computers
Protocols and Ports | Scope | Advanced | Local Principals | Remoate Uzers

Protocols and ports

s Protocol type: [Tce vl

Protocol number:

(=31
£

Local port: | Specific Ports W |
[5432 |
Bxample: 80, 443, 5000-5010

Remote port: |}-"-.II Ports v |

Example: 80, 443, 5000-5010

Imtemet Cortrol Message Protocol
{ICMP) settings:

5. Complete the installation by initializing the database (see SMaRT AFIX Database
Initialization - Windows).
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SMaRT AFIX Database Initialization -
Windows

The information below describes how to initialize the database for the first time, how to
upgrade/migrate an existing database, and how to set up daily jobs.

Prerequisite Tasks

Before initializing the database, confirm that PostgreSQL has been installed.

Initialize a New Database (for the First Time Only)

If this is the first time you are initializing the database, follow the steps below.
Otherwise, see the Upgrade/Migrate an Existing Database instructions.

1. Create a tablespace folder - Use Windows Explorer to create the directory for the
tablespace to be used by SMaRT AFIX. Navigate to the folder C:\Program
Files\PostgreSQL\9 .4, click the New Folder button, and name the new folder
afixdb.

2. Set the folder permissions for afixdb - In Windows Explorer, right-click on the
afixdb folder and select Properties. Click on the Security tab, then click the Edit
button and then the Add button. Enter the name network service and click on the
Check Names button.

3. Your window should like the image below, although your location will be different
and local to your network. Click OK.
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| . Permissions for afixdb

Security

Object name: C\Program Files\PostgreSQL3 4\afixdb

Group aruser names:

P X

Select Users, Computers, Service Accounts, or Groups

Selectthis object type:
Users, Groups, or Built-in security principals [ Object Types... l

From this location:

stchome.com [ Locations... l

Enter the object names to select (examples):
NETWORK SERVICE [ Check Names l

Advanced.. OK l [ Cancel l _

b,
T TF

4. Make sure NETWORK SERVICE is selected and that the Full Control option under
the Allow column is selected. When finished, click OK for all of the remaining

open windows to close them.
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rl afixdb Properties | X |

| General | Sharing | Security | Previous Versions Custnmize|

¢ -
| Permissions for afixdb E

Security

Object name: C:AProgram Files\PostgreSQL\S 4\afixdb

] GFDUD ar user names:

5 CREATOR OWNER

52 SYSTEM

52 Administrators (bleeE5470\Administrators)
52 Users (bleeE5470\Users)

52 Trustedinstaller

[

lca T

| Add.. | | Remove

Permissions for NETWORK
SERVICE Allow Ceny

1 Full control
! Modify

Read & execute

4 Listfolder contents
Read

INEENE
1ioooono

Learn about access control and permissions

] OK | Cancel | | Apply |

5. Create the data directory:

C:\Program Files\PostgreSQL\9.4\afixdb\data

6. Create the olapdata directory:

C:\Program Files\PostgreSQL\9.4\afixdb\olapdata
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7. Download the release distribution zip file and extract the database scripts for the
database server in the afixdb folder:

\DBB\POSTGRES

8. Create the afixdb by navigating to the /DBB/POSTGRES directory and executing the
following command. If prompted, enter the password that was entered during the
Postgres installation.

"c:\Program Files\PostgreSQL\9.4\bin\psqgl.exe" -Upostgres -f
setup_database_win.sql

9. Create the database users and roles by navigating to the /DBB/POSTGRES
directory and executing the following command. If prompted, enter the password
that was entered during the Postgres installation.

"c:\Program Files\PostgreSQL\9.4\bin\psqgl.exe"™ -Upostgres -f
setup_objects.sql afixdb

10. Create the APP configuration schema by navigating to the /DBB/POSTGRES
directory and executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -
sqlMigrationPrefix=APP_V -user=afix migrate

11. Create the ODS schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -
sqlMigrationPrefix=0DS_V -user=afix migrate

12. Create the OLAP schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -
sqlMigrationPrefix=0LAP_V -user=afix migrate

Upgrade/Migrate an Existing Database

If this is not the first time you are initializing the database, follow the steps below.
Otherwise, see the Initialize a New Database (for the First Time Only) instructions.

1. Migrate the APP configuration schema by navigating to the /DBB/POSTGRES
directory and executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=app -
sqlMigrationPrefix=APP_V -user=afix migrate

2. Migrate the ODS schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.
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3.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=ods -
sqlMigrationPrefix=0DS_V -user=afix migrate

Migrate the OLAP schema by navigating to the /DBB/POSTGRES directory and
executing the following command. Enter the password AfixQA.

flyway -url=jdbc:postgresql://localhost:5432/afixdb -schemas=olap -
sqlMigrationPrefix=0LAP_V -user=afix migrate

Set Up a Daily Job / Drop Partition

1.

Copy partition.sql and partition.bat from the /JDBB/POSTGRES directory to
C:\Program Files\PostgreSQL\9.4\afixdb.

Navigate to the /DBB/POSTGRES directory and execute this command:

copy partition.sql C:\Program Files\PostgreSQL\9.4\afixdb
copy partition._bat C:\Program Files\PostgreSQL\9.4\afixdb

Create a Task Scheduler to run the C:\Program
Files\PostgreSQL\9.4\afixdb\partition.bat script daily at 1:00 a.m. to
create future partitions and drop old partitions.

SMaRT AFIX Online Tool Web Service
Installation - Windows

The SMaRT AFIX Online Tool web service is used by the SMaRT AFIX application to
generate an XML file to be uploaded to the CDC's AFIX online tool application. The web
service is a simple web application that is installed alongside the Stand Alone Forecaster
on the Service machine (SVC).

Prerequisites

o p 0N PF

The Postgres database is installed and configured.

The Postgres password for the SMaRT AFIX database is known.
The Tomcat instance is installed on the SVC server.

All necessary ports are open across all firewalls.

The release distribution file for the SMaRT AFIX Online Tool web service is
extracted from /SVC/ONLINE_TOOL/afix.export.ws.war and copied to your local
drive.

Installation Steps

1.

Copy the afix.export.ws._war file to your Tomcat webapps folder.
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2. Restart Tomcat.

3. Update the application properties to point to the proper Postgres database. Make
sure the username and password are correct.

4. Edit the $CATALINA_HOME/webapps/afix.export.ws/WEB-INF/app.properties
file:

driverClassName=org.postgresql .Driver
url=jdbc:postgresql://127.0.0.1:5432/afixdb
username=afixUser

password=afixPassword

5. Restart Tomcat.

Jaspersoft ETL Installation - Windows

Follow these instructions to install Jaspersoft ETL, Apache Web Server, and Subversion,
and to configure the administration console. This installation only needs to occur once.

Prerequisites

1. Java JDK 8 (1.8.91) has been installed.

2. The environment variable JAVA HOME has been set:

JAVA_HOME=[drive]:\directory\Java\1.8 91

3. Copy the components from the distribution /Server Components/ETL directory
into your local directory. These files include:

e license.txt
e TIBCOJaspersoft-JETL-Installer-20150908...zip
o etl.zip

e VisualSVN-Server-3.5.6-x64

Install Jaspersoft ETL

1. Download the Jaspersoft ETL installer zip file and the license file:

Server Components\ETL\TIBCOJaspersoft-JETL-Installer-20150908 1633-
V6.0.1-installer._zip
Server Components\ETL\license.txt

2. Copy the installer and license file into a temporary directory:

c:\user\[user name]\Downloads
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3. Unzip the installer into the temporary directory. Several files will be extracted.
Keep all of the files in the temporary directory for the duration of the installation.

4. From the temporary directory, execute the Windows installer by clicking on:

TI1BCOJaspersoft-JETL-Installer-20150908 1633-V6.0.1-windows-
installer._exe

5. Follow the prompts to accept the license agreement.

6. Follow the prompts to specify the installation directory, installation type, and
license file. Specify [drive:]\Jaspersoft\6.0.1 for the installation directory,
Easy Install for the installation type, and license.txt (found in the temporary
directory).

7. Click the Next button and wait until the installation finishes.

8. Click the Start button, search for services.msc, and then search for any service
named TIBCO Jaspersoft Logserver Collector 6.0.1. Stop this service and set it to
Manual. If there is no service named this, ignore this step.

Start/Stop Jaspersoft ETL Services

The following are the instructions to start and/or stop Jaspersoft ETL services. These
steps are not mandatory on a first-time installation because the services will be running
by default.

Start/Stop Jaspersoft ETL Admin Console

Command to stop the service:

$ cd C:\Jaspersoft\6.0.1\jac
$ stop_tac.bat

Command to start the service:

$ cd C:\Jaspersoft\6.0.1\jac
$ start_tac.bat

Start/Stop Jaspersoft ETL Command Line

Command to stop the service:

$ cd C:\Jaspersoft\6.0.1\cmdline
$ stop_cmdline._bat

Command to start the service:

$ cd C:\Jaspersoft\6.0.1\cmdline
$ start_cmdline.bat
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Start/Stop Jaspersoft ETL Job Server

Command to stop the service:

$ cd C:\Jaspersoft\6.0.1\jobserver
$ stop_jobserver.bat

Command to start the service:
$$ cd C:\Jaspersoft\6.0.1\jobserver

$ start_jobserver._bat

Configure the Admin Console

These steps are used one time only. They should be completed during the server
installation.

1. Navigate to http://[host name]:8080/0rg. jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Navigate to User Settings on the left menu and update the username (if
needed) and library information.
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3. Click on Role and select all of the roles.

Roles Selection x

fend adiclicieb

Role
Administrator
Viewer
er

Operation mana

&
b=

3

esigner

4. Navigate to Project settings from the left menu and add a new project by
clicking the Add button.

5. Name the project as AFIX_ETL, select the Active option, enter AFIX_ETL as the
description and admin admin as the Author, select None as the storage, and
save it.

Project

Label:
Active:
Reference:
Description:
Author:

Storage:

6. Navigate to Project authorization from the left menu. Click on each of the
newly created projects and assign read/write permissions to the user.
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User Authorizations for the Project: AFIX_ETL

Authorizations by Project Authorizations by User

Pro User Authorizations for the Project: AFIX_ETL

Project ... Label a & Type Login Lastname Firstna.. Active
%] admin@stchome.com admin admin @

7. Create the following directories and files in the server:

s
Y

:\Jaspersoft\6.
:\Jaspersoft\6.
:\Jaspersoft\6.
:\Jaspersoft\6.
:\Jaspersoft\6.
:\Jaspersoft\6.
:\Jaspersoft\6.
:\Jaspersoft\6.

0.1\deploy
0.1\deploy\generatedJobs
0.1\deploy\executionLogs
0.1\cmdline\exports
0.1\Audit
O0.1\Audit\reports
0.1\joblogs
0.1\joblogs\log.txt

OO0O0O0O0O0O0O0O0

8. In Primary Command Line configuration, set the path for the Job generation folder
to C:/Jaspersoft/6.0.1/cmdline/exports

] CommandLine/primary (5 Parameters ]

Hast: localhost tu)

Port: 8002 @

Job generation folder: C:/Jaspersoft/6.0.1/cmdline/exports/ @ validity of path cannot be checked
User component path: © Validity of path cannot be checked
Version 6.0.1.20150908_1633 &

9. In Job Conductor configuration, set the path for the Generated jobs folder to
c:/Jaspersoft/6.0.1/deploy/generatedJobs and the path to the Tasks logs
folder to c:/Jaspersoft/6.0.1/deploy/executionlLogs

& job conductor 7 Parameters e

Generated jobs folder: c:/Jaspersoft/6.0.1/deploy/generatedjobs ©
Tasks logs folder: c:/)aspersoft/6.0.1/deploy/executionlogs @
Number of executions log: 1000 ()
Maximum age of log file(d): 0 ©
Maximum number of generated 3 ©
jobs:

Maximum age of generated job(d): |0 (@]
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10. In Logging configuration, set the Technical log file path to
c:/Jaspersoft/6.0.1/joblogs/log

u Logging (4 Parameters / 1 errors o

Technical log file path: c:fJaspersoft/6.0.1/joblogs/log (]
Technical log threshold: WARN ~ @
Business log file path: e

11. In Audit configuration, set the Reports stored path to
c:/Jaspersoft/6.0.1/Audit/reports

I= Audit (& Parameters ©

Url: jdbc:hz2:Cf)aspersoft/6.0.1/jac/apache-tomcat/webag @
User: tisadmin = &
Password:  |eesesees = ©
Driver: org.h2.Driver ~| &
Web Console http://ig-dema-

dbb:2020/org.jaspersoft.administrator/hZconsole

Reports stored path: c:/Jaspersoft/6.0.1/Audit/reports &

12. Navigate to Servers page from the menu and create a new execution server with
the following settings:

e Label: Name of the job server

e Host: ETL Server IP (it usually ends with dbb)
e Command port: 8000

e File transfer port: 8001

e Monitoring port: 83888

e Active: Select this option (enable)

e Username: the admin username for the ETL

e Password: the password for the admin ETL user
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Execution server
Label: gal-etl
Description:
Host: 10.0.5.137
Time zone: &
Command port: | 2000
File transfer E001
port:
Monitoring port: | 2888
Timeout on 120
unknown state
(s):
Username: admin@stchome.com
Password: L T T T T TR R TR R T
Use 55L:
Active:
Jaspersoft Runtims

13. Log in via Remote Desktop to Windows Server using ETL server owner.

14. Copy the etl.zip file (from /DBB/ETL) to a location convenient for you on the
ETL Jaspersoft server to unzip the file, such as a home directory.

15. Unzip the etl _zip file to the server in (C:\) directory (Windows), which creates a
directory structure similar to this:

e C:\etl
e C:\etl\data

e C:\etl\archive

SMaRT AFIX Jaspersoft ETL Deployment -
Windows

The following outlines how to import (migrate) Jaspersoft ETL for SMaRT AFIX.
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Pre-Migration Checklist

Confirm that the Postgres database is installed and configured
Retrieve the passwords for the SMaRT AFIX database (afixdb)
Retrieve the Jaspersoft ETL admin username and password
Confirm that port 8080 is open across all firewalls

Confirm that all of the steps in the Admin Console configuration are completed on
a first-time installation

Copy these components from /DBB/ETL into your local directory:

API_Vaildation_Sequential_Execution_0.1
etl
etl_201703

Forecaster_Sequential_Execution_0.1
ODS_Sequential_Execution_0.1
OLAP_Sequential_Execution_0.1
AFIX_Assessment_Benchmark_ 0.1
LoadVFCEligibleStatus_ OnDemand_0.1
IWeb_User_API_Sequential_Execution_0.1

Identify whether the installation is an upgrade from prior versions or a fresh
installation from scratch.

New Installation Instructions (for the First Time Only)

If this is the first time you deploying Jaspersoft ETL, follow the steps below. Otherwise,
see the Upgrade Instructions.

The steps below only need to be performed once. They should be completed during the
server installation.

Configure the Admin Console

1.

Navigate to http://[host name]:8080/0rg. jaspersoft.administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

Navigate to Project settings from the left menu and add a new project by
clicking the Add button.

Name the new project AFIX_ETL. Select the Active option, enter admin admin
as the Author, and select NONE as the Storage.
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Project

Label:
Active:
Reference:
Description:
Author:

Storage:

4. Navigate to Project authorization from the left menu. Click on the newly
created project and assign read/write permission to the user.

User Authorizations for the Project: AFIX_ETL
Type Login Last name First na... Active Right

W admin@stchome.com admin admin [v] £

5. Navigate to Servers page from the menu and create a new execution server with
the following settings:

e Label: AFIX_jobServer

e Host: ETL Server IP (it usually ends with dbb)
e Command port: 8000

e File transfer port: 8001

e Monitoring port: 8888

e Active: Select this option (enable)

e Username: the admin username for the ETL

e Password: the password for the admin ETL user
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Execution server
Label:
Description:

Host:

Time zZone:
Command port:

File transfer
port:

Monitoring port:

Timeout on
unknown state

(s):
Username:
Password:

Use 55L:

Active:

qab-etl

10.0.5.137

[y

admin@stchome.com

L T T R R R R PP T P

Jaspersoft Runtime

6. Log in via SSH to the Unix server using the ETL server owner.

7. Copy the etl ._zip file (from /DBB/ETL) to a location convenient for you on the

ETL Jaspersoft server to unzip the file, such as a home directory.

8. Unzip the etl.zip file to the server in the root directory (Unix), which creates a
directory structure similar to this:

e c:\et\afix

o c:\etN\afix\api

e c:\etN\afix\archive

e c:\etN\afix\bulkload

e c:\etN\afix\dataout

o c:\etN\afix\input

o c:\etN\afix\rejects

o c:\etN\afix\tmp

e c:\etN\afix\validation
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Deploy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.

2. Copy the following files from the installation files to a convenient location to
deploy:

e IWEB_Staging_Sequential_Execution.zip

e APl _Validation_Sequential _Execution.zip

e ODS_Sequential_Execution.zip

e Forecaster_Sequential_Execution_0.1.zip

e OLAP_Sequential_Execution.zip

e AFIX_Assesment_Benchmark.zip

e LoadVFCEligibleStatus_OnDemand_0.1

e IWeb_User_API_Sequential_Execution_0.1
3. Navigate to the Job Conductor page.

4. Select Add = Normal Task and add the following: Label = AFIX IWEB API
Execution; Description = AFIX IWEB APl Execution.

5. Click Import Generated Jobs and select
the IWEB_Staging_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

6. Click Save.

7. Select Add = Normal Task and add the following: Label = AFIX IWEB API
Validation; Description = AFIX IWEB API Validation.

8. Click Import Generated Jobs and select the
API_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

9. Click Save.

10. Select Add = Normal Task and add the following: Label = AFIX Stage 2 ODS
Load; Description = AFIX Stage 2 ODS Load.

11. Click Import Generated Jobs and select the
ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

12. Click Save.
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13.

14.

15.
16.

17.

18.
19.

20.

21.
22.

23.

24.
25.

26.

27.
28.

Select Add = Normal Task and add the following: Label = AFIX Forecast
Execution; Description = AFIX Forecast Execution.

Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.

Select Add > Normal Task and add the following: Label = AFIX OLAP Execution;
Description = AFIX OLAP Execution.

Click Import Generated Jobs and select the

OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add = Normal Task and add the following: Label = AFIX Assessment
Benchmark; Description = AFIX Assessment Benchmark.

Click Import Generated Jobs and select the

AFIX_Assessment_Benchmark.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add = Normal Task and add the following: Label = Load VFC_Eligible;
Description = Load VFC Eligible.

Click Import Generated Jobs and select the
LoadVFCEligibleStatus_Ondemand.zip file downloaded as part of the prerequisites.
Add the following: Execution Server = AFIX_JobServer; On Unavailable JobServer
= Wait.

Click Save.

Select Add = Normal Task and add the following: Label = IWeb User API;
Description = IWeb User API.

Click Import Generated Jobs and select the
IWeb_User_API_Sequential_Execution_0.1file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable Job Server = Wait.

Click Save.

For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.
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e Email To
e Email SMTP_Host
e Email SMTP_Port
e AFIX_Email_Notification
e Email_Active
e Email_UserName
¢ Email Password
e Web service related parameters (Forecaster):
e SOAP_ACTION
e ENDPOINT
e Database-related parameters:
e AFIX_DB - Login, Password, Port, Database, and Server
e Source_DB_Context - Login, Password, Port, Database, and Server
e RDS-related parameters for ODS_sequential_job
e Psql_Path - Path of the psql (by default, it is Zusr/pgsql-9.4/bin)

e Rds_Postgres - A boolean parameter; set it to True if the database is
RDS

¢ Windows_Execution_Environment - A boolean parameter; set it to
False; the ID of the ETL execution environment is UNIX.

29. Save when finished.
30. Initial load instructions:
¢ Run the AssessmentBenchmark task

e Go to the task AFIX IWeb API Execution. Add the two JVM parameters:
-Xms1024M and -Xmx15690M. Run the AFIX IWeb APl Execution task and
wait to see if it executes without issues. After it starts to make progress,
continue with the next item

Z Refresh & Add
Active JVM parameter Description
& -Xmsl024mM c-'
& -Xmx15690M &
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e Go to the task IWeb API Validation and add a file trigger with the
following values: Label = TriggerValidationAPI, Folder Path =
/etl/afix/dataout, File Mask = API_EXTRACT_Complete.tkn, Pollint(s) = 200

AAATILE Trigge
Add file trigger
Label: TriggerValidationAP| 8]

TriggerValidationAP|

e Go to the task AFIX Stage 2 ODS Load and add a file trigger with these
values: Label = TriggerODSLoad, Folder Path = /etl/afix/dataout, File Mask

= API_VALIDATION_Complete.tkn, Pollint(s) = 200

Add file trigger

e Go to the task AFIX Forecast Execution and add a file trigger with the
following values: Label = TriggerForecast, Folder Path = /etl/afix/dataout,
File Mask = API_LOADS_TO_ODS_Complete.tkn, Pollint(s) = 200. Add the
JVM parameters -Xms1024M and -Xmx15690M

Add tile trigger

APi_LDADS_TO_005_Completnshn
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e Go to the task AFIX OLAP Execution and add a file trigger with the
following values: Label = TriggerOLAP, Folder Path = /etl/afix/dataout, File
Mask = Forecast_Loads_Complete.tkn, Pollint(s) = 200. Add the JVM

parameters -Xms1024M and Xmx15690M

Add file trigger
Label:
Description:

Pollint (s):

TriggerOLAP
TriggerOLAP

1800

Folder path: etl/afix/dataout

File mask: Forecast_Loads_Complete.tkn

Exist:

Created:

Modified:

Execution server: |AWS_AFIX_jobServer v

Pause trigger on
error:

31. Once the initial loads have completed, the ODS and OLAP tables are populated.
Now the daily sequence can be scheduled. Go to the AFIX IWeb APl Execution
task and add the Cron trigger Trigger_IWeb_API. Enter the following values and

save:
e Timezone Strategy: TAC Time
e Minutes: O
e Hours: 0
e Days of Month: Leave blank
e Months: 1,2,3,4,5,6,7,8,9,10,11,12
e Days of the Week: 1,2,3,4,5,6,7

e Years: leave blank

Al Cron irkgpes

B Open cron ety

32. Go to the IWeb User APl Execution task and add the Cron trigger
Trigger_IWeb_User_API. Enter the following values and save:

e Timezone Strategy: TAC Time
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e Minutes: O

e Hours: 0

e Days of Month: Leave blank

e Months: 1,2,3,4,5,6,7,8,9,10,11,12
e Days of the Week: 1,2,3,4,5,6,7

e Years: leave blank

Al Cron irkgpes

2 oven oo

33. Turn on the notify/email feature. Important Note: SMTP needs to be configured
beforehand.

e Select Notifications from the left menu
e Click Add

e Select the Tasks category

e Select On task failed

e Select Enabled

e Select Recipients to specify the user's email. It is better to create an
email group as a recipient so that notifications are sent to multiple people

e Select AFIX ETL Workflow
If the upgrade needs to be aborted for any reason, import the previously created backup.

Alternatively, redeploy the previous version of the content.

Upgrade Instructions

If this is not the first time you are deploying Jaspersoft ETL (i.e., it was deployed earlier),
follow the steps below. Otherwise, see the New Installation Instructions.

The steps below only need to be performed once. They should be completed during the
server installation.
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Configure the Admin Console

1. Navigate to http://[host name]:8080/0rg.jaspersoft._administrator and
enter the default username and password (admin). For the username, use
admin@yourdomain.com or replace it with an email group if the user needs email
notifications on ETL job failure (example: email_group@yourdomain.com).

2. Log in via SSH to the Unix server using the ETL server owner.

3. Copy the etl._zip file (located at /DBB/ETL) to the Jaspersoft ETL server. Use a
location convenient for you to unzip the file, such as a home directory.

4. Unzip the etl.zip file to the server in the Unix root directory (Unix), which adds
the following files that were created as part of this release:

o c:\etl\afix

e c:\etN\afix\api

o c:\etl\afix\archive
e c:\etl\afix\bulkload
o c:\etl\afix\dataout
e c:\etl\afix\input

e c:\etl\afix\rejects

o c:\etl\afix\tmp

e c:\et\afix\validation

Deploy the ETL Components

1. If a previous ETL Projects already exists, perform a backup of it.

2. Copy the following files from the installation files to a convenient location to
deploy:

e APl _Validation_Sequential Execution.zip

e ODS_Sequential_Execution.zip

e Forecaster_Sequential_Execution_0.1.zip

e OLAP_Sequential_Execution.zip

e AFIX_Assesment_Benchmark.zip

e LoadVFCEligibleStatus_OnDemand_0.1

e IWeb_User_API_Sequential_Execution_0.1

3. Navigate to the Job Conductor page.
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10.
11.

12.
13.
14.

15.
16.
17.

18.
19.
20.

21.
22.

Navigate to the task AFIX Assessment Benchmark.

Click Import Generated Jobs and select the AFIX_Assessment_Benchmark.zip
file downloaded as part of the prerequisites. Add the following: Execution server
= AFIX_JobServer; On Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AFIX IWeb API Execution.

Click Import Generated Jobs and select

the IWEB_Staging_Sequential_ Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AFIX IWeb API Validation.

Click Import Generated Jobs and select the
API_Validation_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AFIX Stage 2 ODS Load.

Click Import Generated Jobs and select the

ODS_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.
Navigate to the task AFIX Forecast Execution.

Click Import Generated Jobs and select the
Forecaster_Sequential_Execution.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Click Save.
Navigate to the task AF1X OLAP Execution.

Click Import Generated Jobs and select the

OLAP_Sequential_Execution.zip file downloaded as part of the prerequisites.
Add the following: Execution server = AFIX_JobServer; On Unavailable JobServer
= Recover Task.

Click Save.

Select Add = Normal Task and add the following; Label = Load VFC Eligible;
Description = Load VFC Eligible.
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23.

24.

25.

26.

27.
28.

Click Import Generated Jobs and select the
LoadVFCEligibleStatus_Ondemand_0.1.zip file downloaded as part of the
prerequisites. Add the following: Execution server = AFIX_JobServer; On
Unavailable JobServer = Recover Task.

Select Add = Normal Task and add the following: Label = IWeb User API;
Description = IWeb User API.

Click Import Generated Jobs and select the

IWeb_User_ APl_Sequential_Execution_0.1 file downloaded as part of the
prerequisites. Add the following: Execution Server = AFIX_JobServer; On
Unavailable JobServer = Wait.

For each job created above, update the following Contexts within the Context tab
located at the bottom of the page. Select custom values as needed. If the client is
configured to receive email notifications about failures/successes, then
Email_active should be True; otherwise it should be false. For Email_Active=True,
all of the parameters in the Email section should be keyed in with proper values.

e Email_To

e Email_SMTP_Host

e Email_SMTP_Port

e AFIX_Email_Notification
e Email_Active

e Email_UserName

e Email_Password

e Custom Date: Set to the current date +1. For example, if the current date
is 2017-03-06, the context value should be set to 2017-03-07.

e RDS-related parameters for ODS_sequential_job
e Psgl_Path - Path of the psqgl (by default, it is /usr/pgsql-9.4/bin)

e Rds_Postgres - A boolean parameter; set it to True if the database is
RDS

e Windows_Execution_Environment - A boolean parameter; set it to
False; the ID of the ETL execution environment is UNIX.

Save when finished.

Initial load instructions: Go to the task AFIX IWeb APl Execution. Run the task
and wait to see if the job executes without any issues. Once it has made
progress, make sure each of these tasks is triggered and completes:

e [Web API Validation
e State 2 ODS Load
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Forecast Execution

OLAP Execution

29. Once the initial loads have completed, the ODS and OLAP tables are populated.
Now the daily sequence can be scheduled. Resume the CRON trigger
Trigger_IWeb_API. Go to the task OLAP_Sequential_Execution and change the
context parameter custom date to the original value in
OLAP_Sequential_Execution and save.

30.

Go to the IWeb User API Execution task and add the Cron trigger
Trigger_IWeb_User_API. Enter the following values and save:

Timezone Strategy: TAC Time
Minutes: O

Hours: O

Days of Month: Leave blank
Months: 1,2,3,4,5,6,7,8,9,10,11,12
Days of the Week: 1,2,3,4,5,6,7

Years: leave blank

If the upgrade needs to be aborted for any reason, import the previously created backup.
Alternatively, redeploy the previous version of the content.

JasperReports Server Installation -
Windows

The following instructions explain how to install the JasperReports Server on Windows.

Prerequisite

Download all of the JasperReports Server contents from the distribution site. The JRS
folder contains the following files:

applicationContext-externalAuth-oAuth

applicationContext-security

applicationContext-security-web

InstallCert$SavingTrustManager.class

InstallCert.class

jasperreports-server-6.2.1-windows-64bit-installer.exe

jasperserver.license
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e [atoFont

e stc-jaspersoft-oauth-0.0.1-SNAPSHOT

Installation Steps

1. Download the JasperReports Server for Windows and the license file from the
release distribution:

Server Components\JRS\jasperreports-server-6.2._1-windows-64bit-
installer._exe
Server Components\JRS\jasperserver.license

2. Run the JasperReports Server Installer by right-clicking on the file and selecting
Run as administrator:

Jasperreports-server-6.2.1-windows-64bit-installer.exe

3. Follow the prompts to accept the license agreement.
4. Select the Install All Components and Samples option.

5. Follow the prompts to specify the installation folder. Specify the following
directory:

C:\Jdaspersoft\jasperreports-server-6.2

6. On completion of the installation, start the JasperReports server by selecting the
following:

Launch JasperReports Server Now (for bundled Tomcat and PostgreSQL only)
IT you’re installing on Linux, don"t close the terminal window running
the start script.

7. Validate the installation by logging in to the JasperReports Server console. Use
your browser to access the server. Replace <hostname> below with the name or
IP address of the server:

http://<hostname>:8080/jasperserver-pro

8. Log in with the user ID of superuser and the default password of superuser.
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Expanded Multi-arganization Administration:
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Update the License File

Follow these steps to update the license file for the JasperReports server:

1. Copy the license file (Jasperserver.license) from the distribution site and move
it to your home directory/desktop.

2. Replace the license file in the JasperReports installation directory
(C:\Jaspersoft\jasperreports-server-6.2\) with the license file from the
above step, overwriting the existing jasperserver.license file.

3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).

Increase the JasperReports Session Timeout Period

By default, the JasperReports timeout period is set to 20 minutes. However, the timeout
period should be reset to 32 minutes in order to match with Keycloak.

1. Open web.xml from the path C:\Jaspersoft\jasperreports-server-
6.2\apache-tomcat\webapps\jasperserver-pro\WEB-INF\web _xml.

Search for the property <session-timeout> under <session-config> and update

the value to 32. After this, the property and value should be similar to the image
below:
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3. Restart the JasperReports server (see Start/Stop the JasperReports Server
below).

Start/Stop the JasperReports Server
To start or stop the JasperReports server, click the Start button, go to All Programs >

JasperReports Server > Start or Stop Services, and then select either Start Service
or Stop Service.

JasperReports Configuration with Keycloak

A few configuration changes need to be made in order for JasperReports to be used with
Keycloak.

Prerequisite

Keycloak must be installed and set up, if the SSO-enabled version of IWeb and VOMS is
being used.

JasperReports Server Modifications

1. Edit the following values in the applicationContext-externalAuth-oAuth.xml
file:
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XML Tag

Name(s) to
Update

[KEYCLOAK_URL]

<authorization_lo
cation>

<token_location>

<userdetails_loca
tion>

<logoutUrl>

URL of the Keycloak server. Example: https://sso-

dev.stchome.com/

[KEYCLOAK_REALM]

<authorization_lo
cation>

<token_location>

<userdetails_loca
tion>

<logoutUrl>

Keycloak realm that the client belongs to. This value
needs to be changed, along with <keycloak_URL>.
In this example, the realm name is Dev-Integration:
https://sso-dev.stchome.com/auth/realms/Dev-
Integration

[JASPERSERVER_URL]

<property
name="redirectur
">

<property
name="logoutUrl"
>

URL of the Jasper server. Example:
http://<server_name>:8080/jasperserver-
pro/oauth

[CLIENT_ID]

<property
name="client_id"
>

Client ID as set on Keycloak. Example:

<property name="client_id">
<value>jasper-aws-dev</value>

[CLIENT_SECRET]

<property
name="clientsecr
et'">

<property
name="userdetail
s_secret">

Credentials secret key generated by Keycloak.

State_ID

<property
name="state">

This is the global setting used to populate the
STATE_ID attribute in Jaspersoft. Example:

<bean id="oAuthUserDetailsService"
class="com.jaspersoft.jasperserver.ps.OAuth.OAuthU
serDetailsServicelmpl">

<property name="state">

<value>WA</value>

</property>

</bean>

Jaspersoft Roles

<bean
id="mtExternalUs
erSetupProcessor
class="com.jaspe
rsoft.jasperserver
.multipleTenancy.
security.externalA
uth.processors.M

All the Jaspersoft Roles are configured inside this tag.
If any new Jaspersoft Roles are needed, they must be
configured here. In the <entry> tag, the key value
should match with the client role defined at the
Keycloak end.

Currently, the following roles are configured:
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XML Tag

Name(s) to
~_ Update
TExternalUserSet
upProcessor" 1. Administrator
parent="abstract

ExternalProcessor | 2. Superuser
"

<property 3. User Role

name="organizati
onRoleMap">

<map>

<!-- Example of
mapping
customer roles to
JRS roles -->
<entry>

<key>
<value=>ROLE_AD
MIN_EXTERNAL
ORGANIZATION<
/value>

</key=>
<value>ROLE_AD
MINISTRATOR</v
alue>

</entry>

</map=>

2. Copy the applicationContext-externalAuth-oAuth.xml file (edited in Step 1)
to <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-INF.

3. Copy stc-jaspersoft-oauth-1.0.0.jar (available in the JRS distribution folder) to
<JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-

INF/1ib.

4. Create and save a backup of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-

security.xml file.

5. In <JASPERSERVER_DIR>/apache-tomcat/webapps/jasperserver-pro/WEB-
INF/applicationContext-security.xml, replace the access value for the

method
com. jaspersoft. jasperserver.api.metadata.user.service.ProfileAttribut

eService.putProfileAttribute with ROLE USER.

6. Save a backup copy of the <JASPERSERVER_DIR>/apache-
tomcat/webapps/jasperserver-pro/WEB-INF/applicationContext-security-
web.xml file again and replace the constructor-arg value for
org.springframework.security.web.authentication.LoginUrlAuthenticationEntryPoin
t with Zoauth.
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7. Add the SSL certificate used by Keycloak to the Java installation that Jaspersoft is
using. (By default, Java only knows about a small number of root certificates.) To
do this, follow these steps:

a. Copy InstallCert$SavingTrustManager.class and InstallCert.class
(both available in the STC Suite Distribution/Server Components/JRS
directory) to the <JASPERSERVER_DIR>/java/bin directory.

b. NOTE for sso-dev.stchome.com: This is only for Dev SSO SSL certificate
installation. This URL changes based on your server hostname of the
Keycloak/SSO server.

c. Go to the <JASPERSERVER_DIR>/java/Zbin directory and execute these
commands. The [sso_link] differs based on the environment; an example
might be something like sso-dev.stchome.com.

jJava -cp -\ InstallCert [sso_link]

keytool -exportcert -alias [sso_link]-1 -keystore jssecacerts -
storepass changeit -file [sso_link].cer

keytool -importcert -alias [sso_link] -keystore
-./lib/security/cacerts -storepass changeit -file [sso_link].cer

8. Make database changes with the following commands. Jaspersoft stores all of its
metadata in the Postgres database. All of the user-based profile attributes are
stored in the jiprofileattribute table in Jaspersoft. By default, user attributes
support a character size of 200. In Step E below, the data type size is changed
from 200 to 1,000.

a. Navigate to the <Jasper Installation Directory>/postgres directory.
b. Run this command: psql -U postgres -W (the password is postgres).
c. Now you should see at the prompt: postgres=#

d. Enter this command to connect to the Jasperserver database in Postgres: \c
Jasperserver; (the password is postgres).

e. Execute this SQL alter script: ALTER TABLE jiprofileattribute ALTER
COLUMN attrvalue TYPE character varying(100000);

9. Restart the Jasper server and navigate to JasperUrl/oauth (see example). You

should now be redirected to Keycloak to log in. Example:
http://52.10.228.158:8080/jasperserver-pro/oauth

Steps to Debug Issues Related to
Keycloak/JasperReports Server Integration

If there are any issues with integrating Keycloak with Jasper, follow these suggestions
below.
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Check the applicationContext-externalAuth-oAuth.xml File

Make sure that applicationContext-externalAuth-oAuth.xml is configured with the
correct Keycloak and Jasper server parameters and with the correct client_secret.

Keycloak Mappers
Make sure that the Jasper client has the below mappers mapped correctly in Keycloak,

and check if the Org/fac List mapper contains the correct parameters. (Note that your
API-KEY and API-URI will differ from the image below.

Org/fac List

Protocaol

D
Name
Consent Required OFF
Mapper Type
Token Claim Name org-fac

PI-KEY

API-URI

Response format application/jsan ¥

m Cancel

Name Category Type \
org/fac list Token mapper Org/fac list

email Token mapper User Property

groups Token mapper Group Membership

username Token mapper User Property

realm roles Token mapper Realm Role List

roles Token mapper Client Role List

given name Token mapper User Property

family name Token mapper User Property

full name Token mapper User's full name
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Validate the IWeb Web Service

Make sure that the IWeb web service URL is accessible. The output of this should
return the org/fac list. If there is an error, it needs to be fixed.

3 hemer b G0 8 oebyagl il ik s T

Faw baaden

Check the Whitelist Rules

If Jaspersoft is installed in an AWS environment, the outbound connection on port
8080 should be enabled for the IWeb server.

If Keycloak is installed in an AWS environment, the outbound connection on port 8080
should also be enabled for the IWeb server.

Check the Firewall Rules

If there are any special firewall rules preventing the Jasper and/or Keycloak servers
from accessing IWeb through port 8080, the need to be fixed so that the port is
enabled.

JasperReports Server Upgrade - Windows

These instructions are only required when deploying SMaRT AFIX for the first time or
when upgrading from a version of SMaRT AFIX older than 1.17.4. If you have already
deployed SMaRT AFIX 1.17.4, you should already have the web service plugin installed
on your JasperReports server and can skip these instructions.

As a part of SMaRT AFIX 1.17.4, the new SMaRT AFIX Online Tool web service was
introduced to help support the CDC's AFIX Online Tool application. In order to integrate
this tool with SMaRT AFIX, a plugin must be added to the existing JasperReports server.

Prerequisites

1. JasperReports server has been installed.

2. The web service plugin zip file has been downloaded to your application server
(APP) and the contents extracted. The unzipped folder is referenced as $WS_DS
from this point on.

\APP\JRS\webserviceds v1.0 3.zip
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Locate your JasperReports server web application folder, which is referred to as
$IJRS_HOME from this point on. It is recommended that you back up this folder
before beginning the plugin installation.

C:\Jaspersoft\jasperreports-server-6.2\apache-
tomcat\webapps\jasperserver-pro\

Plugin Installation Steps

The installation should be performed as root user.

1.
2.

3.

Stop your web server running JasperReports server.

Open the folder $WS_DS/JRS/WEB- INF/bundles and copy the contents to
$IRS_HOME/WEB-INF/bundles/. Note that this should not overwrite any existing
files.

Restart the JasperReports server.

Validation Steps

Follow these steps to confirm that the plugin has been successfully installed:

1.
2.

Navigate to your JasperReports server admin console.

Log in as an admin-level user.

TIBCIJaspersoft' # Llibrary View- Manage~ Create~

Home
~ Recently Viewed Items - Data Sources — Domains
CoverageRateReport_Adolescent Report & ] Define connection to a database or other data u_@ Add structure to a data source for use in an
_ source. View tutorial . —] Ad Hoc view. View tuterial
CoverageRateReport_Childhood Report . . . N
Create  View list Create View list
AFIX_Online_Tool Report
MissedOppList_Export Report
MissedOpplList Report Ad Hoc Views Reports
InvalidDoseList_Export Report P Visualize your data for analysis and report Create and format interactive reports from
— d creation. View tutorial z existing Ad Hoc views. View tutorial
InvalidDoseList Report “’
s ©  Create View list Create View list
FullList_Export Report
FullList Report
CoverageRateReport_Adolescent_Export Report Dashboards A Admin
Combine related reports into custom Configure your server instance and manage
dashboard layouts. View tutorial user settings.
» Popular Resources
Create View list View options
® w-to videos
® How-to articles
® Online Learning Portal
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3. Select Create = Data Source from the top menu.

L/ et | \(\n \{ ﬁ \{’ E stchome / afix_reporting X ﬂ TIBCO Jaspersoft: Home X ﬁ

<« C O ‘ (@ 52.37.156.46:3080/jasperserver-pro/flow.html?_flowld=homeFlow

Home

I Apps Google Apps STC Links IWeb Git

TIBCD Jaspersoft” & Library  View.

» Recently Viewed Items
CoverageRateReport_Adolescent Report

CoverageRateReport_ Childhood Report

Timesheets CR145
Manage » Create

Ad Hoc View
Report
Dashboard

Domain

Citrix IE

Sd

anng

Create Vi

4. Confirm that Web Service Data Source is listed in the Type drop-down list.

V ™M V\ 3 | \{ ﬁ K ﬁ stchome [ afix_reporting X yg TIBCO Jaspersoft: New T % _

&« = ﬂ |® Mot secure | 52.37.156.46:8080/jasperserver-pro/flow.html?_flowld =addDataSourceFlow& ParentH

i Apps Google Apps

New Data Source

STC Links Web Git Timesheets

TIBCD Jaspersoft’ # Lbrary view. Manage~

CR145 Citrix JasperSoft KeyCloak

Create »

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.

Type: Web Service Data Source v
AWS Data Source
Bean Data Source
Auth Ty Cassandra Data Source
—— | Internal Diagnostic Data Source
none |JDBC Data Source
JNDI Data Source
L MongoDB Data Source
anguag MongoDB JDBC Data Source
jsan Virtual Data Source
Web Service Data Source
Request Verb:
post
Web Service URI:
sSUperuser
Password:
sesserene
Username:
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SMaRT AFIX JasperReports Deployment -
Windows

The following outlines how to import (migrate) Jaspersoft Reports for SMaRT AFIX.

Pre-Migration Checklist

e Confirm that the Postgres database is installed and configured

e Retrieve the passwords for the SMaRT AFIX database (afixdb)

o Retrieve the Jaspersoft superuser username and password

e Confirm that the SMaRT AFIX Online Tool web service is installed

e Confirm that all necessary ports are open across all firewalls (the default port is
80)

e Confirm that the release distribution zip file for Jasper Reports is extracted from
/APP/JRS/AFI1X_Reports-[version number].zip and copied to your local drive.

e Important: Be sure to update the JasperReports server by following the
instructions in SMaRT AFIX JasperReports Server Upgrade - Windows.

Procedure Steps

Follow these steps to deploy Jaspersoft Reports.

Export the Jaspersoft Repository for Backup

Export the repository by selecting Manage > Server Settings > Export (Export
Everything) in Jaspersoft. Save the file as a backup.
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TI Bc’lJaSpe rsoft’ #A Library Viewv Managev Create~

| Settings Export
Log Settings
File Properties
Log Collectors
Export Data File Name (required):
Ad Hoc Settings .
export.zip
Ad Hoc Cache
OLAP Settings Export Options:
AWS Settings ¥ Export Everything
Server Attributes Roles and Users to Export
Restore Defaults Selected roles and users Users with selected roles Roles with selected users
Import Roles: Users:
® Export > | ‘ A
Resources to Export Assets to Export Events to Export
¥ Data Sources ¥ Sub-organizations Access Events
¥ Domains ¥ Dependencies Audit Events
¥ Ad Hoc Views ¥ Permissions Monitoring Events
Import the Content via the Portal
1. Log in to the Jaspersoft Bl Portal as the administrator user.
2. Navigate to Server Settings > Import.
3. Import the AFIX_Reports-[version number].zip file.
4. Update the data source with the database connection information.

Import the Content via the Command Line

1.
2.

Confirm that JAVA_HOME is set and your path includes jre\bin or jdk\bin.

Change to the buildomatic directory on the JasperReports server:
C:\Jaspersoft\jasperreports-server-6.2.1\buildomatic

Execute the migrate command (adding in the correct version number): js-
import.bat --input-zip "AFIX Reports-[version number].zip" --update -
-skip-user-update --include-access-events --include-audit-events --
include-monitoring-events

Update the data source with the database connection information: From the left
menu, go to root > AFIX > Data Sources. Select AFIX_AWS, then click the
Edit tab. Specify your database connection properties for Host, Port, and
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Password, then click Save.

TIBCD Jaspersoft’ # Llibrary View» Manage~ Create~

£l Folders Repository
(Sl root Run Edit Open Copy Cut Paste Delete
Sl AFIX
E o) Name Description

@l Adhoc Views

{hal Bundles
{flal Dashboards
Data Sources

flal Domains

@l Images

(@l Input Controls
E-Lu Queries

ffal Reports

5. Select AFIX_EXPORT, then click the Edit tab. This is the web service data source
linked to the SMaRT AFIX Online Tool web service.

TIBC® Jaspersoft 4 Lbmy View. Manage. Creates

©| Folders Repository
(= root Run Edit Open Copy | Cut | Paste Delete
Sl AFIX
. o/ Name Description
[+la! Adhoc Views
(Bl Bundles AEEKC AMS
(Bl Dashboards AFIX_EXPORT

E™ Data Sources

[:1_;.. Domains

[+l Images
ol Input Controls
[f}_a- Queries

{#ll Reports

6. Leave the defaults for Auth Type, Language, and Request Verb. Update the web
service URI to point to your SMaRT AFIX Online Tool web service deployment.
Note that even though the Password field is populated, no password is present or
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required; leave it as it is. Click Save when finished.
Edit Data Source: AFIX_EXPORT

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.
Type:

Auth Type:

none

Language:

xml

Request Verb:

get

Web Service URI:

http://10.0.0.12:8080/afix.export.ws/

Password:

Username:

Validate the New Content

The following steps perform a spot check on the newly created content to validate it and
to check for any serious errors. It does not perform a full check of all possible issues and
should be followed up with a functional validation of the content.

1. Log on to the Jaspersoft Bl server as a user able to run a report. The user should
be able to log in successfully and see the subfolders under /root/AFIX (select

View > Repositories).
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il root

Adhoc Views
Bundles
Dashboards
Data Sources
Domains
Images

Input Controls

Queries

H)y FHy Gy o B Ey B By @D

Reports

2. Validate that the user can execute and view a report as defined by their class or
organization membership: Select the report from
AFIX/Reports/AFIX_Online_Tool, select one report from any of the other sub-
directories of AFIX/Reports, and confirm that both reports execute successfully.

Restore the Previous Content (if Necessary)

If there are any uncorrectable issues and the release upgrade needs to be aborted, follow
these steps to revert to the previous content:

1. Using the backup exported at the beginning of these steps, import using the steps
above. Note that a re-import of the previous version of the content will also
achieve the same back-out.

2. Perform the validation steps listed above.

Node.js Installation - Windows

Follow these steps to install Node.js on Windows:

Go to https://nodejs.org and download the recommended version of Node.js.

Run the installer you downloaded.
Follow the prompts in the installer.
Restart your computer.

Open a command window and type: npm install pm2 -g

o 0k~ w0 NP

After the above, type: npm i1 pm2-windows-service -g
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SMaRT AFIX Application Installation
Instructions - Windows

The following instructions explain how to install the application, the Oracle Instant Client,
Visual Studio 2013 Community Edition, Windows SDK v8.1, and Redis; how to configure

the application dashboard and quick links; specific configuration options, and information
on standalone versus multiple application deployment.

If you are upgrading from a previously installed version of SMaRT AFIX, you can skip
directly to the Install the Deployment Package section and continue from there.

Prerequisites

The following should already be installed and configured:

e Windows Server 2012

e PostgreSQL server (DBB)
e Oracle server (COR)

e Node.js (APP)

e PM2 (APP)

Installation and Deployment of SMaRT AFIX, iQ, and
VOMS

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, you only
need to install the Oracle Instant Client, Visual Studio, Windows SDK, and Redis with the
first application installation. Once these are installed, for subsequent applications that
are running on the same server, you can skip down to the Install the Deployment
Package section and continue from there instead.

Install the Oracle Instant Client

1. Download Oracle Instant Client Basic and SDK for Windows. Extract Instant Client
Basic somewhere on the disk (i.e., C:\oracle\instantclient 12 1), then
extract Instant Client SDK into the same folder.

2. Add the path you extracted Oracle Instant Client into to the PATH environment
variable. This can be accessed via the Advanced System Settings window.

3. Add the following system variables. (See https://github.com/oracle/node-
oracledb/blob/master/INSTALL.md#instwin and
https://community.oracle.com/docs/DOC-931127 for more information.)

e OCIL_LIB_DIR to C:\oracle\instantclient_12 1\sdk\lib\msvc
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e OCI_INC_DIR to C:\oracle\instantclient_12 1\sdk\include

Install Visual Studio 2013 Community Edition

See https://www.visualstudio.com/en-us/news/releasenotes/vs2013-community-vs for
download and installation instructions.

Install Windows SDK v8.1

See https://developer.microsoft.com/en-us/windows/downloads/windows-8-1-sdk for
download and installation instructions.

Install Redis
Use this command:

msiexec /1 Redis-x64-3.2.100.msi

See https://qithub.com/MicrosoftArchive/redis and
https://github.com/MicrosoftArchive/redis/releases/tag/win-3.2.100 for more
information.

Install the Deployment Package

Copy the provided zip/tar file to the target server. Extract the archive and change into
the parent of the directory where it was extracted.

Configure the Application Dashboard and Quick Links

If you are installing SMaRT AFIX alongside the iQ and/or VOMS applications, the steps
below only need to be completed the first time an application is installed. This file should
be saved for all subsequent installations.

1. Download the apps-json file from the release distribution application components
shared folder.

2. Edit this file with a text editor and replace the placeholders DASHBOARD_ URL,
IWEB_URL, AFIX_URL, PHC-HUB_URL, 1Q_URL, and VOMS_URL (if applicable for
your installation) with their respective URLs.

3. Save this file and keep it handy as you will need to use it in the installation of iQ,
VOMS, and the SSO dashboard.

An example of one such configuration object in the JSON file is shown below. In most
cases, only the URL value needs to change:

{
icon': "/static/public/img/STC - SmartAFIX.svg",

"id": “AFIX",
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“name': "SMaRT AFIX",

“url': "https://afix.stchome.com ",

"description: "Utilized to make AFIX assessments efficient, standardized and
meaningful .*",

"hidelfUnavailable': true,

"accessRole': "Access_afix"

}

Copy this file to the following location:

<application_install_dir>/src/shared/helpers/appActions/

Configure the Reverse Proxy

A reverse proxy is recommended to provide access to the various products. This is not
explicitly required unless the products are running with the ENABLE_SSL option set to
true. However, this will generally be the case when the products are being run in
conjunction with IWeb on the same server. See the example Apache configurations at
package/docs/apache.

General Product Configuration Options

Once the package containing the products has been installed, there are some
configuration options that can be set depending on the environment. The majority of
these lie in package/process. json, which is simply a JSON configuration file for pm2.
The options listed in bold below need to be changed to match your environment. Other
options not in bold might not need to change, and in most cases can be the default
setting. Some options in the process. json file are not listed at all below; those options
should be left unchanged.

The options are as follows:

Option \Description \

script Location of the startup script application. The path to the script
may need to be customized.

cwd The path to the application. May need to be customized.

PRODUCT The name of the product.

HOST The host name for the product.

APIHOST The host name of the product's respective API server (generally
localhost).

PORT The port for the product.

APIPORT The port for the product's APl server.

NODE_ENV This should always be production.

SAML__ISSUER The SAML issuer (client) from Keycloak.

SAML_ENTRY_POINT The SAML entry point from Keycloak.
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Option
JASPER_SERVER

\Description

The domain name of the JasperReports server.

REDIS_URL

The Redis URL used for storing client sessions.

REVERSE_PROXY

When configuring SMaRT AFIX with a reverse proxy, this should be
set to true.

ENABLE_SSL

When set to true, this enables HTTPS support. If REVERSE_PROXY
is set to true, this should be set to false even when the
environment is configured for HTTPS.

SECRET_SESSION

The secret key for session storage. IMPORTANT NOTE: This value
must be exactly the same for every application, in both the server
and the API environment variables.

SMaRT AFIX-Specific Configuration Options

The following options are specific to SMaRT AFIX configuration settings:

(@]e]ue]]g]
VOMS_ORACLE_USER

Description \

The username for IWeb's SIIS database. This is set to the
default user for the SIIS, but may need to be updated
depending on your configuration.

VOMS_ORACLE_PASSWORD

The password for IWeb's SIIS database. This is set to the
default password for the SIIS, but may need to be updated
depending on your configuration.

VOMS_ORACLE_CONNECTION

Connection information for IWeb's SIIS database. This needs
to be updated to point to your IWeb's Oracle database
instance.

PG_USER

The user account for the SMaRT AFIX PostgreSQL database.

PG_PASSWORD

The password for the associated PG_USER for the SMaRT AFIX
PostgreSQL database.

PG_HOST

The hostname for the SMaRT AFIX PostgreSQL database.

PG_PORT

The port number for the SMaRT AFIX PostgreSQL database.

AFIX_EXPORT_URI

The URL for the SMaRT AFIX Online Tool web service. Only the
hostname and possibly the port number for the URL need to be
updated.

AFIX_EXPORT_KEY

The API Key for the SMaRT AFIX Online Tool web service. This
should be left as the default.

CDSI1_FORECASTER_VERSION

The current version of the CDSI Forecaster deployed. For the
SMaRT AFIX 1.17.5.4 release, it should be set to 5.17.10.

API_URL_PREFIX

This should be set to Zapi
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Standalone SMaRT AFIX vs. Multiple Application
Deployment

The SMaRT AFIX bundle you were provided contains an Org-Fac-Micro-Service include in
the process. json file that looks something like the example below. The same micro-
service is included in the process. json file for the iQ application. If you are deploying
SMaRT AFIX alongside iQ, this service should only be included in the process. json file
for the first application you deploy. It needs to be removed from the process. json file
for all other applications.

{

"name™ : "org-fac-micro-service",

“script” : "afix-pre-windows/services/bin/service.js",

""instances" 2,

"exec_mode™ - "cluster",

"cwd" : "afix-pre-windows/services",

“"env': {

""NODE_ENV™ : "production”,

""SERVICE" : "facilitySearch",

""SERVICE_PORT" = 3060,

""SAML_ ISSUER" : "dev-portal”,

"SAML_ENTRY_POINT"" : "https://sso-dev.stchome.com/auth/realms/Dev-
Integration/protocol/saml",

"JASPER_SERVER" : "iInterop-aws-jaspersoft._stchome.com™,

"REDIS_URL™ : "redis://localhost:6379",{

""VOMS_ORACLE_USER" : "user",

""'VOMS_ORACLE_PASSWORD" : "password",

""VOMS_ORACLE_CONNECTION"" - "(DESCRIPTION = (ADDRESS = (PROTOCOL =
TCP) (HOST = 10.0.0.1)(PORT = 1521)) (CONNECT_DATA = (SID = SID)))",

}
3.

NOTE: Due to variations in the org-fac-micro-service between the different applications (SMaRT
AFIX, VOMS, and iQ), it is recommended that you deploy the service that is bundled with SMaRT
AFIX instead of the one bundled with other applications.

Run the Application

Use pm2 to run the deployment package as shown below. In many cases, environment-
specific configuration options must be set prior to running an application's package. See
the configuration option sections above for more details.

pm2 start package-parent/process.json

Start the Products upon Bootup

To have the products automatically start on every boot, do the following once it has been
verified that they are running correctly:

npm install -g pm2-windows-service
pm2-service-install [-n service-name]
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pm2 save
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Keycloak Configuration for
SMaRT AFIX

This task is to be performed during SSO installation of the application. The table below
lists each application and component, along with the JSON file name, client name, and
URL placeholder name for each. Make sure to use the correct file and other information
corresponding to the specific application/component installation.

Application Name \JSON File Name \Client Name \URL Placeholder Name

IWeb iweb.json iweb IWEB-URL
PHC-Hub phchub.json phc-hub PHC-HUB-URL
Jasper Report Server |jasper.json jasper JASPER-URL

iQ interop.json interop INTEROP-URL
VOMS voms.json voms VOMS-URL
Logviewer interop-logviewer.json [interop-logviewer |[LOGVIEWER-URL
Dashboard dashboard.json dashboard DASHBOARD-URL

Import the Client and Roles (First Time
Only)

These steps explain how to import the client and configure the roles.

Prerequisites

The location of the JSON file for the application being installed.

Import Steps

1. Log in to Keycloak.

2. Select the desired realm for the application suite in the top left drop-down list.

3. Click Import on the left side menu.

4. Click the Select File button and browse to the SMaRT AFIX release /SSO/JSON
directory.

5. Select the afix. json file and click Open.

6. Important: In the If a resource exists drop-down list, select Skip.

7. Select the afix_Provider_Group.json file and click Open.

8. Important: In the If a resource exists drop-down list, select SKip.
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9.

10.

Select the afix_ManageUsers_Role. json file and click Open.

Important: In the If a resource exists drop-down list, select SKkip.

Configure the Client

©® N o o

10.

On the left side menu, click Clients.
Locate the client named afix you just imported (see above) and click Edit.

On the Settings tab, enter the URL to the application everywhere there is a URL
placeholder.

If the Client Protocol is SAML, expand the Fine Grain SAML Endpoint Configuration
section at the bottom of the page and make sure the URL placeholders are
replaced with the application URL.

Click the Save button at the bottom.
Click on the Mappers tab.
Locate the user-type mapper and click the Edit button.

In the API-URI box, replace the URL placeholder with the URL to your IWeb
installation.

Verify the API-KEY is set to the APl key of your IWeb instance.

Click the Save button at the bottom.

Upgrade Instructions

Before upgrading, make sure you know the location of the JSON file for the application
being installed.

Import Steps

1
2
3.
4

a

Log in to Keycloak
Select the desired realm for the application suite in the top left drop-down list.
Click Import on the left side menu.

Click the Select File button and browse to the SMaRT AFIX release /SS0/JSON
directory.

Select the afix_Provider_Group.json file and click Open.
Important: In the If a resource exists drop-down list, select SKip.

Select the afix_ManageUsers_Role. json file and click Open.
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8. Important: In the If a resource exists drop-down list, select Skip.
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